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CUSTREVENUE Command Syntax 




The command to run CUSTREVENUE uses the syntax shown below. Parameter switches are case insensitive; you can enter them in either upper or lower case (-c or -C). If a parameter includes a space, you must enclose it in quotes (for example, -s "11/01/1999 12:00:00"). Also, when you enter the command, you must either supply the path to the program, or run it from the directory in which it is stored (typically, \LODESTAR\BIN). 






CustRevenue 

-c

connectstring [-q

qualifier] [-f

configfilename] -v OPCO:JUR:RS[:VER]:[:RC][

-s

startdate] [-t

stopdate] [-a

 (a|c)(a|i|l [*]|f) name] [-b

intdb] [-w

outputname][-i#

intervaldatahandling] [-rp

reportoptions] [-rop

reportoptions]  




In actual use, the command must be entered on one line. Also, you must either change to the directory in which the program is stored (typically, \LODESTAR\bin) before entering the command, or specify the path in the command. To view a list of all parameters on-screen, type  custrevenue -? at the command prompt.








		



Parameter 




		



Description 










		



-c 




		





connectstring  is database connection information for the Oracle Utilities Data Repository. This parameter is required and must be in one of the following formats:











For Oracle databases: 











"Data Source=<data_source>;User ID=<user_id>;Password=<password>;LSProvider=ODP;" 











where: 








		

•




		



<data_source> is the Oracle TNS Name for the data source, from the TNS_NAMES.ora file (typically located in the \\<machine>\oracle\network\admin directory)  





















		

•




		



<user_id> is the user ID for the database connection 





















		

•




		



<password> is the password for the supplied user ID. 























		



-q 




		





qualifier   is an optional database qualifier. The default is PWRLINE.










		



-f 




		





configfilename  is the name of the configuration file that defines the working environment of the Oracle Utilities software (directs the software where to find and place the application data files, and so on). If you do not supply a value for configfilename, the system uses the default (LODESTAR.CFG). See Chapter 2: Configuration Files in the Oracle Utilities Energy Information Platform Configuration Guide for more information about this file.










		



-a 




		





(a|c)(a|i|l [*]|f)name   Account/Customer All/Id/List/File name. The default is no account. An * immediately after l means refresh the list.











If -aaf is specified, the file must be one of the following: 








		

•




		



a list of customer/account IDs (*.ids) 





















		

•




		



a list file (*.lst) 





















		

•




		



an account query file (*.qra) 





















		

•




		



a customer query file (*.qrc). 



















Examples :








		

•




		





All Accounts 

: -aaa























		

•




		





Account ID : -aai555888





















		

•




		





Account List : -aalMAC_RUNRS_ACCTLIST





















		

•




		





Account ID File : -aafMAC_RUNRS_ACCTFILE.ids. This file exists in the specified user directory (defined on the User Files tab of the Default Options dialog)























		



-b 




		





filename  is the name of the Interval Database that contains the interval data for the calculations.  The default is selected via the Interval Data Source tab on the General Options dialog.











A file name that is simply RDB specifies the interval data table selected on the Interval Data Sources tab on the Default Options Data Manager dialog (see  Interval Data Source on page 2-12 in the Data Manager User's Guide).










		



-w 




		





filename  is the name that the program assigns to the output reports. If you do not supply this option, the program displays the output on screen and does not produce a file.










		



-i# 




		



Set interval data handling. Same values as INTD_ERROR_STOP (0,1,2,3). Default # is 1 (error stop). If not set, the  On Rules Language Interval Data Error option specified on the Error Handling tab of the General Options dialog is used.










		



-rp 




		



Turn on all Report Options - Problem Determination. 










		



-rop 




		





eibr  Any combination of e|i|b|r. Sets Report Options - Problem Determination. Turn on Error Messages, Input options, Show Bill History, Show Rate Schedule.










		



-rogs 




		



Display summaries only.  Sets Report Options - General Options. Turns on the Display Summaries Only option 










		



-v 




		





OPCO :JUR:RS[:VER][:RC] is the identifier for the rate form. It is required (except when you supply an account ID/list using the -a switch, and corresponding records exist in the Rate Code History table). OPCO, JUR, RS are the operating company code, jurisdiction code, and rate form code (respectively) that identify the rate form.




You can specify a NULL operating company or jurisdiction by leaving a blank space where OPCO or JUR would be. 




The version number is optional. If you do not supply a version number, the program automatically uses the rate form that was applicable on the  stop date of the analysis period (specified using the -t switch). If you supply a version number, the program uses the trial version indicated (you would typically do this for testing). RC is the Rate Code if one is used. This is optional. See the  Data Manager User's Guide for additional information about this convention for identifying rate forms.










		



-s 




		



From test period Bill month. MM/YYYY format 










		



-t 




		



To test period Bill month. MM/YYYY format 
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Bill Frequency 




You can run Bill Frequency in batch mode using the BILLFREQUENCY.EXE command line program. 
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CUSTIMPACT Command Syntax 




The command to run CUSTIMPACT uses the syntax shown below. Parameter switches are case insensitive; you can enter them in either upper or lower case (-c or -C). If a parameter includes a space, you must enclose it in quotes (for example, -s "11/01/1999 12:00:00"). Also, when you enter the command, you must either supply the path to the program, or run it from the directory in which it is stored (typically, \LODESTAR\BIN). 






CustImpact 

-c

connectstring [-q

qualifier] [-f

configfilename] -v OPCO:JUR:RS[:VER]:[:RC][-s

startdate] [-t

stopdate] [-a

 (a|c)(a|i|l [*]|f) name] [-b

intdb] [-w

outputname] [-k

saveresults][-i#

intervaldatahandling] [-rp

reportoptions] [-rop

reportoptions]  [-m

minimum bill][-n

advanced analysis name] [-z##

advanced $ diff absolute range] [-y 

advanced % diff][-g

advanced rpt all customer] [-h

advanced report all over threshold] [-jname

advanced savinglist name] [-k

best rate] [-oname

advanced blocking name]  [-lcfg

logging configuration filename] 




In actual use, the command must be entered on one line. Also, you must either change to the directory in which the program is stored (typically, \LODESTAR\bin) before entering the command, or specify the path in the command. To view a list of all parameters on-screen, type  custimpact -? at the command prompt.








		



Parameter 




		



Description 










		



-c 




		





connectstring  is database connection information for the Oracle Utilities Data Repository. This parameter is required and must be in one of the following formats:











For Oracle databases: 











"Data Source=<data_source>;User ID=<user_id>;Password=<password>;LSProvider=ODP;" 











where: 








		

•




		



<data_source> is the Oracle TNS Name for the data source, from the TNS_NAMES.ora file (typically located in the \\<machine>\oracle\network\admin directory)  





















		

•




		



<user_id> is the user ID for the database connection 





















		

•




		



<password> is the password for the supplied user ID. 























		



-q 




		





qualifier  is an optional database qualifier. The default is PWRLINE.










		



-f 




		





configfilename  is the name of the configuration file that defines the working environment of the Oracle Utilities software (directs the software where to find and place the application data files, and so on). If you do not supply a value for configfilename, the system uses the default (LODESTAR.CFG). See Chapter 2: Configuration Files in the Oracle Utilities Energy Information Platform Configuration Guide for more information about this file.










		



-v 




		





OPCO :JUR:RS[:VER][:RC] is the identifier for the rate form. It is required (except when you supply an account ID/list using the -a switch, and corresponding records exist in the Rate Code History table). OPCO, JUR, RS are the operating company code, jurisdiction code, and rate form code (respectively) that identify the rate form.




You can specify a NULL operating company or jurisdiction by leaving a blank space where OPCO or JUR would be. 




The version number is optional. If you do not supply a version number, the program automatically uses the rate form that was applicable on the stop date of the analysis period (specified using the -t switch). If you supply a version number, the program uses the trial version indicated (you would typically do this for testing). RC is the Rate Code if one is used. This is optional. See the  Data Manager User's Guide for additional information about this convention for identifying rate forms.










		



-s 




		



A start-date value is  required. You can use any of the following formats:






Explicit Dates 








mm 

/

dd

/

yyyy



hh

:

mm

:

ss

or yyyy

-

mm

-

dd hh

:

mm

:

ss






Absolute value for date and time of the period's beginning. The time (hh:mm:ss) is optional, and defaults to midnight. 













mm /dd/yyyy-hh:mm






Alternate, acceptable format (used by Oracle Utilities Load Analysis). If this format is used, times are adjusted. As start time of 00:01 will automatically be changed to 00:00:00, and a stop time of 24:00 will become 23:59:59 













Relative Dates 








D 

##   You can specify a relative date in days, where ## is the number of days before the current date and time, beginning at midnight (the "current date and time" are the date and time when the RUNRS job starts). D0 represents the current date, beginning at midnight. D3 represents three days previous, beginning at midnight.






M 

#   You can specify a relative date in months, where # is the number of calendar months before the month containing the current date, starting at midnight on the first of the month.  M0 is the current month, beginning on the 1st at midnight ("current date" refers to the date when the RUNRS job starts).






Note:    mm, dd, and yyyy are all numeric. If you supply the time, you must enclose the parameter in double quotes, because the date and time are separated with a space; for example, "11/18/1998 01:00:00"












		



-t 




		



A stoptime value is  optional. You can use any of the following formats:













Explicit Dates 








mm 

/

dd

/

yyyy



hh

:

mm

:

ss

or yyyy

-

mm

-

dd hh

:

mm

:

ss






Absolute value for date and time of the period's beginning. Time is optional; midnight is the default. 













mm /dd/yyyy-hh:mm






Alternate, acceptable format (used by Oracle Utilities Load Analysis). If this format is used, times are adjusted. A start time of 00:01 will automatically be changed to 00:00:00, and a stop time of 24:00 will become 23:59:59. 













Relative Dates 








D 

## You can specify a relative date in days, where ## is the number of days after the current date and time, beginning at midnight (the "current date and time" are the date and time that the RUNRS job starts). D0 represents the current date, at 23:59:59. D3 represents three days previous, beginning at midnight.













M 

# You can specify a relative date in months, where # is the number of calendar months after the month containing the current date, starting at midnight on the first of the month. M0 is the current month, beginning on the 1st at midnight. (Again, "current date" refers to the date when the RUNRS job starts.)






Note:   mm, dd, and yyyy are all numeric. If you supply the time, you must enclose the parameter in double-quotes, because the date and time are separated with a space; for example, "11/18/1998 01:00:00"












		



-a 




		





(a|c)(a|i|l [*]|f)name   Account/Customer All/Id/List/File name. The default is no account. An * immediately after l means refresh the list.











If -aaf is specified, the file must be one of the following: 








		

•




		



a list of customer/account IDs (*.ids) 





















		

•




		



a list file (*.lst) 





















		

•




		



an account query file (*.qra) 





















		

•




		



a customer query file (*.qrc). 



















Examples :








		

•




		





All Accounts 

: -aaa























		

•




		





Account ID : -aai555888





















		

•




		





Account List : -aalMAC_RUNRS_ACCTLIST





















		

•




		





Account ID File : -aafMAC_RUNRS_ACCTFILE.ids. This file exists in the specified user directory (defined on the User Files tab of the Default Options dialog)























		



-b 




		





filename  is the name of the Interval Database that contains the interval data for the calculations.  The default is selected via the Interval Data Source tab on the General Options dialog.











A file name that is simply RDB specifies the interval data table selected on the Interval Data Sources tab on the Default Options Data Manager dialog (see  Interval Data Source on page 2-12 in the Data Manager User's Guide).










		



-w 




		





filename  is the name that the program assigns to the output reports. If you do not supply this option, the program displays the output on screen and does not produce a file.










		



-i# 




		



Set interval data handling. Same values as INTD_ERROR_STOP (0,1,2,3). Default # is 1 (error stop). If not set, the  On Rules Language Interval Data Error option specified on the Error Handling tab of the General Options dialog is used.










		



-rp 




		



Turn on all Report Options - Problem Determination. 










		



-rop 




		





eibr  Any combination of e|i|b|r. Sets Report Options - Problem Determination. Turn on Error Messages, Input options, Show Bill History, Show Rate Schedule.










		



-rogs 




		



Display summaries only.  Sets Report Options - General Options. Turns on the Display Summaries Only option 










		



-m 




		



Append Minimum Bill - Turns on the Minimum Bill Report 










		



-lcfg 




		





logging configuration filename  Name of an optional logging configuration file that specifies where error and log messages are sent. If you omit this parameter, the application creates a log file named RUNRS.LOG in the LOG directory.










		



Advanced Customer Impact Inputs — Optional 










		



-n 




		





Analysis Name : Optional. Type a name to appear in the report window's title bar.










		



-z## 




		



Switch Threshold - $ Difference Absolute Range.  Supply a dollar value. If you use this option, the program will flag customers with a dollar difference between revenue from the base rate schedule and revenue from any of the other rate schedules greater than the amount you supplied (for the entire test period). This value is divided by the number of months in the test period and the result is used as the absolute comparison value for each month; the input value is used as the comparison value for the total of all months. 










		



-y## 




		



Switch Threshold - % Difference - Percent Diff. Supply a percent value. If you use this option, Customer Impact flags customers with a percent difference between revenue from the base rate schedule and revenue from any of the other rate schedules greater than the amount you supplied (total difference is compared, not monthly difference). 










		



-g 




		



Switch Threshold Reports - If you selected any switch threshold options, you can choose  All Customers if you don't want to limit the output.










		



-h 




		



Switch Threshold Reports - Reports If you selected any switch threshold options, you can choose  All Over Threshold if you want to report just those customers that may switch to another rate schedule.










		



-j 




		





name  Switch Threshold Saving List Name - If you want the program to create a list of the customers who may switch to another rate schedule, enter a name for the list here using the -j parameter.










		



-k 




		



Switch Threshold - Assign each customer to its best rate's list. Use this switch (if you want the program to create a list for each rate (the list name is the supplied list prefix appended with the rate schedule name). A customer will be added to a rate list if the customer's bill is the minimum on that rate (ties go to the first rate with the minimum). 










		



-o 




		





name  Billing Impact Frequency Report - Blocking Name. If you use this switch, a Billing Impact Frequency Report page will be appended to the Customer Impact Report. You must select a blocking to use in creating this report. The blocking can contain at most 201 steps (-100 to 100 by 1,-500 to 500 by 5, etc.).  Enter the blocking name after the -o parameter. Example: -o"0 - 500 by 100"














Command Line Example: 




C:\lodestar\bin\CustImpact -cdsn1 -uuserid -ppassword  -aclDDC_G_IND_500kW_Commparison -wd:\powrline\user\custimp\cstimpminbill.txt  -s"01/01/2003"  -t"12/31/2003" -v"GPC:GA:GPC_G-10:401:018" -v"GPC:GA:GPC_PLL-2:401:005" -v"GPC:GA:GPC_TOU-GSD:403:008" -z150 -m -n"0 - 500 by 100" -ros  -f"d:\lodestar.cfg" 
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Customer Revenue 




You can run Customer Revenue in batch mode using the CUSTREVENUE.EXE command line program. 
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TYPICALBILL Command Syntax 




The command to run TYPICALBILL uses the syntax shown below. Parameter switches are case insensitive; you can enter them in either upper or lower case (-c or -C). If a parameter includes a space, you must enclose it in quotes (for example, -s "11/01/1999 12:00:00"). Also, when you enter the command, you must either supply the path to the program, or run it from the directory in which it is stored (typically, \LODESTAR\BIN). 






Typicalbill 

-c

connectstring [-q

qualifier] [-f

configfilename] -v OPCO:JUR:RS[:VER]:[:RC][-s

billmonth] [-a

 (a|c)(a|i|l [*]|f) name] [-b

intdb] [-w

outputname] [-i#

intervaldatahandling][-rp

reportoptions] [-rop

reportoptions]  [-p compute cents] [-d

Determinant and values] 




In actual use, the command must be entered on one line. Also, you must either change to the directory in which the program is stored (typically, \LODESTAR\bin) before entering the command, or specify the path in the command. To view a list of all parameters on-screen, type  typicalbill -? at the command prompt.








		



Parameter 




		



Description 










		



-c 




		





connectstring  is database connection information for the Oracle Utilities Data Repository. This parameter is required and must be in one of the following formats:











For Oracle databases: 











"Data Source=<data_source>;User ID=<user_id>;Password=<password>;LSProvider=ODP;" 











where: 








		

•




		



<data_source> is the Oracle TNS Name for the data source, from the TNS_NAMES.ora file (typically located in the \\<machine>\oracle\network\admin directory)  





















		

•




		



<user_id> is the user ID for the database connection 





















		

•




		



<password> is the password for the supplied user ID. 























		



-q 




		





qualifier   is an optional database qualifier. The default is PWRLINE.










		



-f 




		





configfilename  is the name of the configuration file that defines the working environment of the Oracle Utilities software (directs the software where to find and place the application data files, and so on). If you do not supply a value for configfilename, the system uses the default (LODESTAR.CFG). See Chapter 2: Configuration Files in the Oracle Utilities Energy Information Platform Configuration Guide for more information about this file.










		



-a 




		





(a|c)(a|i|l [*]|f)name   Account/Customer All/Id/List/File name. The default is no account. An * immediately after l means refresh the list.











If -aaf is specified, the file must be one of the following: 








		

•




		



a list of customer/account IDs (*.ids) 





















		

•




		



a list file (*.lst) 





















		

•




		



an account query file (*.qra) 





















		

•




		



a customer query file (*.qrc). 



















Examples :








		

•




		





All Accounts 

: -aaa























		

•




		





Account ID : -aai555888





















		

•




		





Account List : -aalMAC_RUNRS_ACCTLIST





















		

•




		





Account ID File : -aafMAC_RUNRS_ACCTFILE.ids. This file exists in the specified user directory (defined on the User Files tab of the Default Options dialog)























		



-b 




		





filename  is the name of the Interval Database that contains the interval data for the calculations.  The default is selected via the Interval Data Source tab on the General Options dialog.











A file name that is simply RDB specifies the interval data table selected on the Interval Data Sources tab on the Default Options Data Manager dialog (see  Interval Data Source on page 2-12 in the Data Manager User's Guide).










		



-w 




		





filename  is the name that the program assigns to the output reports. If you do not supply this option, the program displays the output on screen and does not produce a file.










		



-i# 




		



Set interval data handling. Same values as INTD_ERROR_STOP (0,1,2,3). Default # is 1 (error stop). If not set, the  On Rules Language Interval Data Error option specified on the Error Handling tab of the General Options dialog is used.










		



-rp 




		



Turn on all Report Options - Problem Determination. 










		



-rop 




		





eibr  Any combination of e|i|b|r. Sets Report Options - Problem Determination. Turn on Error Messages, Input options, Show Bill History, Show Rate Schedule.










		



-rogs 




		



Display summaries only.  Sets Report Options - General Options. Turns on the Display Summaries Only option 










		



-v 




		





OPCO :JUR:RS[:VER][:RC] is the identifier for the rate form. It is required (except when you supply an account ID/list using the -a switch, and corresponding records exist in the Rate Code History table). OPCO, JUR, RS are the operating company code, jurisdiction code, and rate form code (respectively) that identify the rate form.




You can specify a NULL operating company or jurisdiction by leaving a blank space where OPCO or JUR would be. 




The version number is optional. If you do not supply a version number, the program automatically uses the rate form that was applicable on the  stop date of the analysis period (specified using the -t switch). If you supply a version number, the program uses the trial version indicated (you would typically do this for testing). RC is the Rate Code if one is used. This is optional. See the  Data Manager User's Guide for additional information about this convention for identifying rate forms.










		



-s 




		



Bill month. MM/YYYY format 










		



-p 




		



Compute Cents per determinant name. 










		



-d 




		



Determinant and values. More than one can be specified: -dDET, LOW, HIGH, STEP 






Example :




-dKWH,0,100,10 
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Help Icons 




A number of icons appear along the top of the online help window. These icons are used for navigating the online help and other functions.These icons perform the following functions: 








		



Icon 




		



Description 










		





[image: ]






		





Show Navigation : Open the navigation frame. Used after opening a single help topic.










		





[image: ]






		





Previous : Display the previous help topic.










		





[image: ]






		





Next : Display the next help topic.










		





[image: ]






		





Show in Contents : Expand the Contents tab to display the current topic.










		





[image: ]






		





E-mail : Send email to Customer Support.










		





[image: ]






		





Print : Print the current topic.










		





[image: ]






		





Bookmark : Save the current topic as an Internet Explorer Favorite..
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BILLFREQUENCY Command Syntax 




The command to run BILLFREQUENCY uses the syntax shown below. Parameter switches are case insensitive; you can enter them in either upper or lower case (-c or -C). If a parameter includes a space, you must enclose it in quotes (for example, -s "11/01/1999 12:00:00"). Also, when you enter the command, you must either supply the path to the program, or run it from the directory in which it is stored (typically, \LODESTAR\BIN). 






BillFrequency 

-c

connectstring [-q

qualifier] [-f

configfilename] -v OPCO:JUR:RS[:VER]:[:RC][-s

startdate] [-t

stopdate] [-a

 (a|c)(a|i|l [*]|f) name] [-b

intdb] [-w

outputname][-i#

intervaldatahandling] [-rp

reportoptions] [-rop

reportoptions] [-n

Analysis Name][-e

Bill frequency table name] 




In actual use, the command must be entered on one line. Also, you must either change to the directory in which the program is stored (typically, \LODESTAR\bin) before entering the command, or specify the path in the command. To view a list of all parameters on-screen, type  billfrequency -? at the command prompt.








		



Parameter 




		



Description 










		



-c 




		





connectstring  is database connection information for the Oracle Utilities Data Repository. This parameter is required and must be in one of the following formats:











For Oracle databases: 











"Data Source=<data_source>;User ID=<user_id>;Password=<password>;LSProvider=ODP;" 











where: 








		

•




		



<data_source> is the Oracle TNS Name for the data source, from the TNS_NAMES.ora file (typically located in the \\<machine>\oracle\network\admin directory)  





















		

•




		



<user_id> is the user ID for the database connection 





















		

•




		



<password> is the password for the supplied user ID. 























		



-q 




		





qualifier   is an optional database qualifier. The default is PWRLINE.










		



-f 




		





configfilename  is the name of the configuration file that defines the working environment of the Oracle Utilities software (directs the software where to find and place the application data files, and so on). If you do not supply a value for configfilename, the system uses the default (LODESTAR.CFG). See Chapter 2: Configuration Files in the Oracle Utilities Energy Information Platform Configuration Guide for more information about this file.










		



-a 




		





(a|c)(a|i|l [*]|f)name   Account/Customer All/Id/List/File name. The default is no account. An * immediately after l means refresh the list.











If -aaf is specified, the file must be one of the following: 








		

•




		



a list of customer/account IDs (*.ids) 





















		

•




		



a list file (*.lst) 





















		

•




		



an account query file (*.qra) 





















		

•




		



a customer query file (*.qrc). 



















Examples :








		

•




		





All Accounts 

: -aaa























		

•




		





Account ID : -aai555888





















		

•




		





Account List : -aalMAC_RUNRS_ACCTLIST





















		

•




		





Account ID File : -aafMAC_RUNRS_ACCTFILE.ids. This file exists in the specified user directory (defined on the User Files tab of the Default Options dialog)























		



-b 




		





filename  is the name of the Interval Database that contains the interval data for the calculations.  The default is selected via the Interval Data Source tab on the General Options dialog.











A file name that is simply RDB specifies the interval data table selected on the Interval Data Sources tab on the Default Options Data Manager dialog (see  Interval Data Source on page 2-12 in the Data Manager User's Guide).










		



-w 




		





filename  is the name that the program assigns to the output reports. If you do not supply this option, the program displays the output on screen and does not produce a file.










		



-i# 




		



Set interval data handling. Same values as INTD_ERROR_STOP (0,1,2,3). Default # is 1 (error stop). If not set, the  On Rules Language Interval Data Error option specified on the Error Handling tab of the General Options dialog is used.










		



-rp 




		



Turn on all Report Options - Problem Determination. 










		



-rop 




		





eibr  Any combination of e|i|b|r. Sets Report Options - Problem Determination. Turn on Error Messages, Input options, Show Bill History, Show Rate Schedule.










		



-rogs 




		



Display summaries only.  Sets Report Options - General Options. Turns on the Display Summaries Only option 










		



-v 




		





OPCO :JUR:RS[:VER][:RC] is the identifier for the rate form. It is required (except when you supply an account ID/list using the -a switch, and corresponding records exist in the Rate Code History table). OPCO, JUR, RS are the operating company code, jurisdiction code, and rate form code (respectively) that identify the rate form.




You can specify a NULL operating company or jurisdiction by leaving a blank space where OPCO or JUR would be. 




The version number is optional. If you do not supply a version number, the program automatically uses the rate form that was applicable on the  stop date of the analysis period (specified using the -t switch). If you supply a version number, the program uses the trial version indicated (you would typically do this for testing). RC is the Rate Code if one is used. This is optional. See the  Data Manager User's Guide for additional information about this convention for identifying rate forms.










		



-s 




		



From test period Bill month. MM/YYYY format 










		



-t 




		



To test period Bill month. MM/YYYY format 










		



-n 




		





Optional.  Analysis Name. This will appear on top of the report. This parameter is for Revenue










		



-e 




		



Bill frequency table name. This parameter is for revenue. 
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Using Online Help 




Oracle Utilities applications provide browser-based online help. 




How to open online help: 








		

1.




		



Select  Help Contents from the Help menu. The online help opens in a browser window.





















		

2.




		



Locate the topic you need help about via the Contents tab, Index tab, or Search tab. 





















		

•




		



The  Contents tab allows users to expand/collapse sections of the table of contents as needed to find a particular topic. Click on the book icons ([image: ] and [image: ]) to open/close headings. Click on the topic icon ([image: ])to open it.





















		

•




		



The  Index tab allows the user to browse an index for the online help. Click on the index entry for the topic to open it.





















		

•




		



The  Search tab allows the user to search the online help for specific words. Enter the word(s) for the search in the text box and click Go!

 The search results appear beneath the text box. Click on the topic to open it.























		

3.




		



The selected topic will appear in the right pane of the online help window. 
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Typical Bill 




You can run Typical Bill in batch mode using the TYPICALBILL.EXE command line program. 
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Creating Graphs 




You can also create graphs from data in open report windows.  




How to Create a Graph: 








		

1.




		



Select the Graph option from the View Menu (available only when an open report window is displayed), the Create Graph dialog opens. 





















		

2.




		



Select an Account ID you wish to graph from the Select Account ID to Graph box. A list of available rows to graph will appear in the Select Rows to Graph box. 





















		

3.




		



Select a row to include on the graph and click Add. The selected row will appear in the Pairs to Graph box. Repeat this step for each Account ID/row pair you wish to include in the graph.  

















To remove a pair, select it and click  Remove.








		

4.




		



Enter an optional title for the graph in the Title box and click OK. The graph will appear in a window. 





















		

5.




		



To change the view of the graph, select from the options in the View menu. 





















		

•




		



The Style option allows you to select from bar graph style (as above) or line graph style. 





















		

•




		



The Background Color option allows you select the background color for the graph (White, Gray, Dark Gray, or Black). 
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Printing Reports 




You can also print reports using the Print option (from the File menu). When you select the Print option, the Print dialog opens. 




To print the report, complete the Print dialog as appropriate: 








		

•




		





Ignore page breaks:  Check this to ignore the page breaks in the report.





















		

•




		





Page width in characters:   Enter the desired width of the report.





















		

•




		





Display line numbers:   Check this to include line numbers on the report.

















Once you've completed the dialog, click  OK. A standard Windows Print dialog will open, allowing to set any desired print options.
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Changing the Appearance of Reports 




You can also change the appearance of the text in an open report window using the Font option (from the Edit menu). When you select the Font option, the Font dialog opens. 




To change the font in the report window, select a new Font, Style, and Size and click  OK. The text in the report window will display and print the font/style/size selected.
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Moving to a Specific Line in a Report 




You can also jump to a specified line number within an open report window by using the Go to option. The Go to option (selected from the Edit Menu) allows you to move to a specific line in an open report window. When you select this option (or press  Ctrl-G), the Go To tab on the Find dialog opens.




Enter the line number in the report that you wish to move to and click  OK.
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Viewing and Searching Reports 




You can search for a specific word or words (or numbers) in an open report window using the  Find option. The Find option (selected from the Edit Menu) allows you to search for a word or words in an open report window. When you select this option (or press F3), the Find dialog opens.




Enter the word or words you wish to find and click  OK. To find the next instance of the word or words with the Find dialog still open, click Find Next. To find the previous instance of the word or words with the Find dialog still open, click Find Previous.




Once you've entered a word or words in the Find dialog, you can search by using the Find Next or Find Previous options from the Edit menu. 








		

•




		



To search for the next instance of the word or words last entered in the Find dialog, select the  Find Next (or press Shift-F3) option.





















		

•




		



To find the previous instance of the word or words last entered in the Find dialog, select the  Find Previous (or press Ctrl-F3)option.
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Viewing and Printing Reports 




One of the primary functions of Oracle Utilities applications is to generate reports. Each of the various analysis modules generate reports, and the programs also generate a number of other useful reports as well.  




Once a report has been generated, it appears in an open report window on the application desktop. Once in an open report window, you can view and/or print the report. This section describes how to view and print reports generated using Oracle Utilities applications. 








OEBPS/Text/part0030.xhtml






Bill Calculation Results Columns Options 




The Bill Calculation Results Columns tab allows users to specify the labels of the Bill Calculation Results section of a bill report. 




The Bill Calculation Results section displays the number of billing units, the distribution of those billing units, the charge rate, and revenue for each revenue identifier used in a rate schedule. 




Bill Calculation Results Columns Options 








		

•




		



To change one or more of the Bill Calculation labels, check the  Change Bill Calculation Labels checkbox and edit the labels as appropriate.





















		

•




		



To omit one or more of the columns from the bill report (except the Revenue column), check the  Change Bill Calculation Labels checkbox and delete the appropriate label.



















Billing Units Label : The label for the Billing Units column. If blank, the column is omitted.






Distribution Label : The label for the Distribution column. If blank, the column is omitted.






Charge Rate Label : The label for the Charge Rate column. If blank, the column is omitted.






Revenue Label : The label for the Revenue column. This column cannot be omitted. If blank, the column label is Revenue.
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Problem Determination Options 




The Problem Determination tab allows users to specify the level of problem determination detail included in both a bill report and a transaction record. 




When problems occur during the processing of a bill, error messages and other information useful in determining the cause of the problem are created. The  Problem Determination tab option enables you to specify how much of that data is included in the reports and transaction records.




Problem Determination Options 






Show All Error Messages:  This option reports all error messages that occur while processing the bill.






Show All Input Options:  This option reports all input options used in processing the bill.






Show Bill records to Save (BillHistory, CSS, etc).  This option includes the Bill History records in the Bill Report. It is typically only used for testing. If you turn this option off, the records are still output when you approve a bill, but they are not displayed or printed in the bill report.






Show Rate Schedule Used in Bill Calculation:  This option includes the rate schedule used in processing the bill on the bill report.
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Hours Use Matrix 




You can run Hours Use Matrix in batch mode using the HOURSUSEMATRIX.EXE command line program. 








OEBPS/Text/part0122.xhtml






HOURSUSEMATRIX Command Syntax 




The command to run HOURSUSEMATRIX uses the syntax shown below. Parameter switches are case insensitive; you can enter them in either upper or lower case (-c or -C). If a parameter includes a space, you must enclose it in quotes (for example, -s "11/01/1999 12:00:00"). Also, when you enter the command, you must either supply the path to the program, or run it from the directory in which it is stored (typically, \LODESTAR\BIN). 






HoursUseMatrix 

-c

connectstring [-q

qualifier] [-f

configfilename] -v OPCO:JUR:RS[:VER]:[:RC][-s

startdate] [-t

stopdate] [-a

 (a|c)(a|i|l [*]|f) name] [-b

intdb] [-w

outputname][-i#

intervaldatahandling] [-rp

reportoptions] [-rop

reportoptions] [-l

Blocking names]




In actual use, the command must be entered on one line. Also, you must either change to the directory in which the program is stored (typically, \LODESTAR\bin) before entering the command, or specify the path in the command. To view a list of all parameters on-screen, type  hoursusematrix -? at the command prompt.








		



Parameter 




		



Description 










		



-c 




		





connectstring  is database connection information for the Oracle Utilities Data Repository. This parameter is required and must be in one of the following formats:











For Oracle databases: 











"Data Source=<data_source>;User ID=<user_id>;Password=<password>;LSProvider=ODP;" 











where: 








		

•




		



<data_source> is the Oracle TNS Name for the data source, from the TNS_NAMES.ora file (typically located in the \\<machine>\oracle\network\admin directory)  





















		

•




		



<user_id> is the user ID for the database connection 





















		

•




		



<password> is the password for the supplied user ID. 























		



-q 




		





qualifier   is an optional database qualifier. The default is PWRLINE.










		



-f 




		





configfilename  is the name of the configuration file that defines the working environment of the Oracle Utilities software (directs the software where to find and place the application data files, and so on). If you do not supply a value for configfilename, the system uses the default (LODESTAR.CFG). See Chapter 2: Configuration Files in the Oracle Utilities Energy Information Platform Configuration Guide for more information about this file.










		



-a 




		





(a|c)(a|i|l [*]|f)name   Account/Customer All/Id/List/File name. The default is no account. An * immediately after l means refresh the list.











If -aaf is specified, the file must be one of the following: 








		

•




		



a list of customer/account IDs (*.ids) 





















		

•




		



a list file (*.lst) 





















		

•




		



an account query file (*.qra) 





















		

•




		



a customer query file (*.qrc). 



















Examples :








		

•




		





All Accounts 

: -aaa























		

•




		





Account ID : -aai555888





















		

•




		





Account List : -aalMAC_RUNRS_ACCTLIST





















		

•




		





Account ID File : -aafMAC_RUNRS_ACCTFILE.ids. This file exists in the specified user directory (defined on the User Files tab of the Default Options dialog)























		



-b 




		





filename  is the name of the Interval Database that contains the interval data for the calculations.  The default is selected via the Interval Data Source tab on the General Options dialog.











A file name that is simply RDB specifies the interval data table selected on the Interval Data Sources tab on the Default Options Data Manager dialog (see  Interval Data Source on page 2-12 in the Data Manager User's Guide).










		



-w 




		





filename  is the name that the program assigns to the output reports. If you do not supply this option, the program displays the output on screen and does not produce a file.










		



-i# 




		



Set interval data handling. Same values as INTD_ERROR_STOP (0,1,2,3). Default # is 1 (error stop). If not set, the  On Rules Language Interval Data Error option specified on the Error Handling tab of the General Options dialog is used.










		



-rp 




		



Turn on all Report Options - Problem Determination. 










		



-rop 




		





eibr  Any combination of e|i|b|r. Sets Report Options - Problem Determination. Turn on Error Messages, Input options, Show Bill History, Show Rate Schedule.










		



-rogs 




		



Display summaries only.  Sets Report Options - General Options. Turns on the Display Summaries Only option 










		



-v 




		





OPCO :JUR:RS[:VER][:RC] is the identifier for the rate form. It is required (except when you supply an account ID/list using the -a switch, and corresponding records exist in the Rate Code History table). OPCO, JUR, RS are the operating company code, jurisdiction code, and rate form code (respectively) that identify the rate form.




You can specify a NULL operating company or jurisdiction by leaving a blank space where OPCO or JUR would be. 




The version number is optional. If you do not supply a version number, the program automatically uses the rate form that was applicable on the  stop date of the analysis period (specified using the -t switch). If you supply a version number, the program uses the trial version indicated (you would typically do this for testing). RC is the Rate Code if one is used. This is optional. See the  Data Manager User's Guide for additional information about this convention for identifying rate forms.










		



-s 




		



From test period Bill month. MM/YYYY format 










		



-t 




		



To test period Bill month. MM/YYYY format 










		



-l 




		



Demand blocking name and hours use blocking name. This parameter needs to be specified twice. First one will be demand blocking. 
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Crossing Point 




You can run Crossing Point in batch mode using the CROSSINGPOINT.EXE command line program. 
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CROSSINGPOINT Command Syntax 




The command to run CROSSINGPOINT uses the syntax shown below. Parameter switches are case insensitive; you can enter them in either upper or lower case (-c or -C). If a parameter includes a space, you must enclose it in quotes (for example, -s "11/01/1999 12:00:00"). Also, when you enter the command, you must either supply the path to the program, or run it from the directory in which it is stored (typically, \LODESTAR\BIN). 






CrossingPoint 

-c

connectstring [-q

qualifier] [-f

configfilename] -v OPCO:JUR:RS[:VER]:[:RC][-s

billmonth] [-t

minimum difference] [-e

determinant codes] [

-n

determinant index][-a

 (a|c)(a|i|l [*]|f) name] [-b

intdb] [-w

outputname] [-i#

intervaldatahandling] [-rp

reportoptions] [-rop

reportoptions]  




In actual use, the command must be entered on one line. Also, you must either change to the directory in which the program is stored (typically, \LODESTAR\bin) before entering the command, or specify the path in the command. To view a list of all parameters on-screen, type  crossingpoint -? at the command prompt.








		



Parameter 




		



Description 










		



-c 




		





connectstring  is database connection information for the Oracle Utilities Data Repository. This parameter is required and must be in one of the following formats:











For Oracle databases: 











"Data Source=<data_source>;User ID=<user_id>;Password=<password>;LSProvider=ODP;" 











where: 








		

•




		



<data_source> is the Oracle TNS Name for the data source, from the TNS_NAMES.ora file (typically located in the \\<machine>\oracle\network\admin directory)  





















		

•




		



<user_id> is the user ID for the database connection 





















		

•




		



<password> is the password for the supplied user ID. 























		



-q 




		





qualifier   is an optional database qualifier. The default is PWRLINE.










		



-f 




		





configfilename  is the name of the configuration file that defines the working environment of the Oracle Utilities software (directs the software where to find and place the application data files, and so on). If you do not supply a value for configfilename, the system uses the default (LODESTAR.CFG). See Chapter 2: Configuration Files in the Oracle Utilities Energy Information Platform Configuration Guide for more information about this file.










		



-a 




		





(a|c)(a|i|l [*]|f)name   Account/Customer All/Id/List/File name. The default is no account. An * immediately after l means refresh the list.











If -aaf is specified, the file must be one of the following: 








		

•




		



a list of customer/account IDs (*.ids) 





















		

•




		



a list file (*.lst) 





















		

•




		



an account query file (*.qra) 





















		

•




		



a customer query file (*.qrc). 



















Examples :








		

•




		





All Accounts 

: -aaa























		

•




		





Account ID : -aai555888





















		

•




		





Account List : -aalMAC_RUNRS_ACCTLIST





















		

•




		





Account ID File : -aafMAC_RUNRS_ACCTFILE.ids. This file exists in the specified user directory (defined on the User Files tab of the Default Options dialog)























		



-b 




		





filename  is the name of the Interval Database that contains the interval data for the calculations.  The default is selected via the Interval Data Source tab on the General Options dialog.











A file name that is simply RDB specifies the interval data table selected on the Interval Data Sources tab on the Default Options Data Manager dialog (see  Interval Data Source on page 2-12 in the Data Manager User's Guide).










		



-w 




		





filename  is the name that the program assigns to the output reports. If you do not supply this option, the program displays the output on screen and does not produce a file.










		



-i# 




		



Set interval data handling. Same values as INTD_ERROR_STOP (0,1,2,3). Default # is 1 (error stop). If not set, the  On Rules Language Interval Data Error option specified on the Error Handling tab of the General Options dialog is used.










		



-rp 




		



Turn on all Report Options - Problem Determination. 










		



-rop 




		





eibr  Any combination of e|i|b|r. Sets Report Options - Problem Determination. Turn on Error Messages, Input options, Show Bill History, Show Rate Schedule.










		



-rogs 




		



Display summaries only.  Sets Report Options - General Options. Turns on the Display Summaries Only option 










		



-v 




		





OPCO :JUR:RS[:VER][:RC] is the identifier for the rate form. It is required (except when you supply an account ID/list using the -a switch, and corresponding records exist in the Rate Code History table). OPCO, JUR, RS are the operating company code, jurisdiction code, and rate form code (respectively) that identify the rate form.




You can specify a NULL operating company or jurisdiction by leaving a blank space where OPCO or JUR would be. 




The version number is optional. If you do not supply a version number, the program automatically uses the rate form that was applicable on the  stop date of the analysis period (specified using the -t switch). If you supply a version number, the program uses the trial version indicated (you would typically do this for testing). RC is the Rate Code if one is used. This is optional. See the  Data Manager User's Guide for additional information about this convention for identifying rate forms.










		



-s 




		



Bill month. MM/YYYY format 










		



-t 




		



Minimum difference (double value) 










		



-e 




		



Determinant codes for KWH, KW and <Load Factor>, respectively: 




-eKWH, KW,<Load Factor> 










		



-n 




		



Determinant index (0,1, or 2). This is used only if -e is specified. 
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The Purpose of the Hours Use Matrix Report 




The Hours Use Matrix Report is a summary report that shows totals for revenue calculations.  The report shows the comparison of the base or current rate to each proposed rate.  A page of the report is created for each base rate to proposed rate comparison.  




The details of each proposed rate comparisons are printed as an 8 by 8 matrix or array. The report data is grouped in the array slots based on each customers calculated hours use and demand (or hours use block). A separate section of the report called the Hours Use Comparison Report is created for each rate. The Hours Use Comparison Report section shows the Hours Use Matrix in a different format and includes the cumulative kWh and demand values. 






Important Note:  In order to use Hours Use Matrix report, you must include the HOURS_USE_REPORT=1 parameter in the LODESTAR.CFG file. See Chapter 2: Configuration Files in the Oracle Utilities Energy Information Platform Configuration Guide for more information.




The Hours Use Matrix report can also be run in batch mode using a command line program. For more information, see  

Hours Use Matrix

 of 

Appendix B

: 

Setting Up Oracle Utilities Rate Management to run in Batch Mode

.
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Required Inputs 




Before you can use the Hours Use Matrix report, you must have already created and saved the rate schedules and blockings you wish to use in the report. Note that the rate schedules used with the Hours Use Matrix report  must use the $EFFECTIVE_REVENUE identifier. Also, Demand is represented as kW. The rate schedules selected must use kWh and kW.




Energy and Demand Identifiers 




Each rate schedule selected for use with the Hours Use Matrix Report must assign appropriate Energy and Demand values based on its billing energy and demand. These values are derived from specific rate schedule identifiers. The list below specifies the identifiers that should be used and their priorities. The program will search through this list to determine the Demand and Energy values to be used based on the identifiers used in the rate schedule. If none of the listed identifiers are found, an error message will print. 








		



Priority 




		



Energy Identifier 










		



1 




		



HOURS_USE_REPORT_ENERGY 










		



2 




		



KWH 










		



3 




		



CBL_KWH 


















		



Priority 




		



Demand Identifier 










		



1 




		



HOURS_USE_REPORT_DEMAND 










		



2 




		



BILL_DEMAND 










		



3 




		



PK_KW 










		



4 




		



PK_KVA 










		



5 




		



CBL_BILL_DEMAND 










		



6 




		



BILLING_DEMAND 
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Sample Minimum Bill Report Output 




At the end of the report the total number of minimum bill accounts will print. This number could be different from the number of minimum bills reported each month -- for example, if an account has 10 minimum bills, the account will be counted only once in the total at the end of the report, not 10 times. Each row will show the cumulative count of minimum bills. Below is a sample of a minimum bill report based on the sample rate schedule and rider above. Actual printed report may look slightly different that this example. 











11/27/2000  MINIMUM BILL REPORT Page: 2 











Computation Period: 03/1999 to 02/2000 











Schedule: MPC_LGS  






YEAR MO #Min Bills  kWh Peak kW Billing Demand  Min Bill  Min Base Chg   Min Bill Demand Chg   Total Revenue 








 1996 MAR    7   12854   239.6         44.5     1450.25          0.00               1450.25         1623.77 








 1996 APR    6   12760   204.6         55.0     1657.50          0.00               1657.50         1829.75 








 1996 MAY    2   13100   274.0         33.0     5530.25          0.00               5530.25         5707.09 








 1996 JUN    1    9800   593.0         25.0     4714.25          0.00               4714.25         4846.54 








 1996 JUL    4   15140   396.0         35.0     4874.25          0.00               4874.25         5078.62 








 1996 AUG    8   53580   568.0         66.6     5443.00          0.00               5443.00         6166.28 








 1996 SEP    3   14140   180.0         37.5     2362.25          0.00               2362.25         2553.12 








 1996 OCT    4   19740   326.0         25.5     3123.00          0.00               3123.00         3389.47 








 1996 NOV    2   18540   355.0         38.0     3123.00          0.00               3123.25         3373.28 








 1996 DEC    3   19940   249.0         26.5     2490.25          0.00               2490.25         2759.43 








 1997 JAN    2   11980   152.0         12.0     2034.25          0.00               2034.25         2195.97 








 1997 FEB    3   10026    81.0         10.5     2139.00          0.00               2139.00         2274.35 








   Total:    45 211600   3618.2        344.6    38941.25          0.00              38941.25        41797.67 













THE NUMBER OF ACCOUNTS RECEIVING A MINIMUM BILL IS: 8 
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Running the Hours Use Matrix Report 




This chapter explains how to use the Hours Use Matrix Report. This report is a summary report that shows totals for revenue calculations. 








		

•




		





The Purpose of the Hours Use Matrix Report 

























		

•




		





Running the Hours Use Matrix Report 
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Purpose of the Interschedule Mapping Table 




The Interschedule Mapping Table enables you to "pair" a rate code in one rate schedule with the most similar rate code in a second rate schedule.  




This feature is useful when performing "what if" bill calculations or revenue analysis that apply rate schedules with rate code-dependent charges to customers currently on a different rate schedule/rate code. 




For example, imagine that you want to find the result of applying your company's General Service rate to a customer currently on an Industrial rate.  Further, say that the general service rate includes two different customer charges—one for customers on rate code GS-1 and another for customers on GS-2 (these charges are specified in the rate form using the SELECT RATE CODE statements). If the customer's current rate code is anything other than GS-1 or GS-2, the trial calculations will skip the customer charges entirely.  However, if you map the industrial rate code to, say, the GS1 code in the Interschedule Mapping Table, the analysis program will apply the charges associated with GS1 when calculating the customer's trial bill or revenue. 




The Interschedule Mapping Table is stored in the Oracle Utilities Data Repository, where it is available for use with the Oracle Utilities Billing Component, Oracle Utilities Rate Management, and other analysis programs. You must use the Data Manager Browser to add, update, or delete entries in the table.  
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Print Detail Options 




The Print Detail tab allow users to specify the level of detail included in both a bill report and transaction record. The information computed and available for reporting is determined by the statements used in the applicable rate form. The  Print Detail tab enables you to specify how much of that available data is included in the reports and transaction records.




Print Detail Options 






Default:  This option means the program will use the Print Detail setting normally applied to the account (via the Account, Rate Code, Rate Schedule, or Global options specified). Alternately, you can override the usual setting for just this job by selecting one of the following:






None:  This option displays effective revenue only.






Normal Detail:  This option displays effective revenue, plus any charges assigned to a revenue identifier and any values assigned to a Report Statement in the applicable rate form.






All Detail:  This option displays effective revenue, plus revenue identifiers, plus the values associated with the Rules Language Label and Report statements in the rate form.




The table below details how these options apply to specific components of a report and transaction record.  








		



Report Component 




		



None 




		



Normal 




		



All  










		



Customer/Account Detail 




		



X 




		



X 




		



X 










		



Input Values 




		










		



X 




		



X 










		



LABELed Identifier Values 




		










		










		



X 










		



Simple Report Values 




		










		



X 




		



X 










		



Compound Report Values 




		










		



X 




		



X 














Print Detail Items 




To override the  Print Detail Options setting for specific components of a bill report and transaction record, select the specific options for each component in the Print Detail Items section of the dialog. For each report component type, select one of the following:








		

•




		





On  - Include the component in the report and transaction record.





















		

•




		





Off  - Exclude the component from the report and transaction record.





















		

•




		





Print Detail 

Option - Apply the setting specified under Print Detail 

Options. The specific manner in which these settings affect individual report components is detailed in the table above. For example, if you had selected "None" under Print Detail 

Options, and selected Print Detail Option here for Input Values, the input values would not appear in the report.

















Following is a brief description of each of the report components. 






Customer/Account Detail.  Date activated, billing mode, number of days specified for the eligibility pre- and post-windows.






Input values.  This option reports the parameters specified for the bill calculations: bill start and end date; date that the account's meter was scheduled to be read; rate code applied to the account; number of days in bill period, and the bill month.






LABELed Identifier Values.  This option reports the any identifier values and text strings specified using a LABEL Statement in the rate form. LABEL statements are typically used to substitute meaningful labels for bill determinant names or other brief and sometimes-cryptic identifiers (e.g., LABEL LF "LOAD FACTOR" displays LOAD FACTOR and its value in the report). They are often used for column headings or report subtitles.






Note:  If a report component type is designated to appear in a report, and it is assigned a name using a LABEL Statement, its values will automatically appear in the report, with the new label. In other words, it is not necessary in that case to apply the LABELED identifier values option to get the label and value to appear. For example, the applicable rate form might have the statement LABEL $EFFECTIVE_REVENUE "Total Charges". Because Effective Revenue is automatically included in all report types, "Total Charges" will appear, no matter what print details options you choose.






Simple report values.  This option reports any values that were assigned to an identifier using a REPORT Statement in the rate form. REPORT statements are typically used to report values of interest that are calculated and/or drawn from the database, such as peak times.






Compound report values.  This option reports any values associated with a stem identifier using a REPORT Statement in the rate form.
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Some Important Rules for Mapping Codes 




Important points to keep in mind when defining rate code mappings include: 








		

•




		



You can map a rate code to just one rate code in the second rate schedule (in other words, one rate code in the first schedule cannot be paired with multiple rate codes in the second schedule), however... 





















		

•




		



You can map more than one rate code in the first schedule to the same rate code in the second schedule. 





















		

•




		



Oracle Utilities Rate Management's Customer Impact Analysis automatically uses the mappings defined in the Interschedule Mapping Table. 
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General Options 




The General tab allows users to set presentation and output options for a report. 




Report Titles 




To add optional titles to a report, enter the title in one of the three optional title fields. 




Saving Reports to Files 




To write the report to a file, check the "Write report directly to File" check box and specify the path and filename for the file. Use the "Browse" button to locate an existing file. To display the report also, check the "Also Display Report" checkbox. 




Other Options 








		

•




		



To disable graphing for the report, check the "Disable graphing of data" checkbox. 





















		

•




		



To display only summaries for the report, check the "Display summaries only" checkbox. 





















		

•




		



To keep the report data for CSV/XML exporting, check the "Keep data" checkbox. 
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Running the Hours Use Matrix Report 




How to Run an Hours Use Matrix Report: 








		

1.




		



Select  Analysis-›Hours Use Matrix.

















The  Hours Use Matrix dialog box appears.








		

2.




		



Select the Customers/Accounts for the report. 



















Select By:   Choose either Account or Customer. Select the accounts or customers of interest using one of the following options:








		

•




		





All:   Select this option if you want to apply the analysis to all accounts or customers in the database.





















		

•




		





ID:  Type the ID of one account or customer.





















		

•




		





List:  Select the list that contains the IDs of the customers or accounts that you want to include in the analysis. If you believe that the contents of the list may have changed since the last time that the query associated with it was run, check the box for Refresh list before using. This option updates the list for this job and saves the new version of the list to the database, replacing the old version. See the Data Manager User's Guide for information about creating Customer and Account lists.





















		

3.




		



Specify the  Test Period From/To: by entering the start- and end-month using the MM/YYYY format.





















		

4.




		



Select the rate schedules to use in the report. Select the first rate schedule by first clicking the  Add button.

















The  Select Rate Schedule and Optional Rate Code dialog box appears.




Select an  Operating Company, Jurisdiction, and Rate Schedule.




Check one or more rate schedule  Types (Current/Historical or Trial).  Your selections here will determine which schedule types are displayed in the Type selection box (e.g., if you click just the Trial box, only those schedules stored as "Trial" will be available for selection in theselection box).




Highlight one rate schedule in the selection box.




To help you make your selection, Oracle Utilities Rate Management displays the first 50 lines of the selected rate schedule text in the lower window. If you wish to view the entire schedule (beyond 50 lines), click  Show All. The text in this window is view-only—you cannot edit the schedule here.




If the rate schedule includes SELECT RATE CODE statements that apply different calculations for different rate codes, you must select one of the rate codes to be used in the analysis run. There are two options: select a rate code using the  From Rate Schedule Rate Code drop-down list, o leave the From Rate Schedule Rate Code field empty. In the latter case, the report applies the first rate code in the schedule.




Click  OK to return to the Hours Use Matrix dialog box.




Repeat this step as many times as needed to add comparison rate schedules. To update the rate schedule selection information, highlight the rate schedule you wish to change and select  Update. To remove a rate schedule from the analysis, select Delete.




From the set of rate schedules, highlight the rate schedule you wish to use as the basis for comparison in the report. The other (non-highlighted) rate schedule(s) will be compared to the highlighted schedule. 






Note:  Each rate schedule selected must assign HOURS_USE_REPORT_ENERGY and HOURS_USE_REPORT_DEMAND.








		

5.




		



Select the  Demand Blocking and the Hours Range Blocking from the drop down lists. The blocking can contain at most 201 steps (-100 to 100 by 1, -500 to 500 by 5, etc.). The demand Blocking will represent how the demand (kW's) will be grouped. The hour range Blocking will represent how the hours use (kWh /kW) will be grouped. For more information on blocking, see 

Creating a New Blocking

 of this manual.





















		

6.




		





Optional.  If you want to override your default options for this report, click the Options button. See



Default Options

 for more information.























		

7.




		



Click the  Report button to run the report.
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Report Options 




Report options allow users to customize the contents of a report, including the report presentation and output, the print detail level, problem determination options, and the appearance of the Bill Calculation Results section of reports. 






Note : Changes to report options as described in this section apply only to the report currently being run.




Users access the Report Options via tabs at the top of the Report Options dialog. Clicking on these tabs allows users to navigate between types of report options, including: 








		

•




		





General Options 

























		

•




		





Print Detail Options 

























		

•




		





Problem Determination Options 

























		

•




		





Bill Calculation Results Columns Options 





















How to set and save report options: 








		

1.




		



Click the  Report Options button in the input dialog box for the report you're creating. The Report Options dialog appears.





















		

2.




		



Make any appropriate changes on the  General, Print Detail, Problem Determination

, and 

Bill Calculation Results Columns tabs.



















Note : Not all report options are available for all reports. If an option is not available, it is greyed out.








		

3.




		



Click  OK to save the changes. To close the Report Options dialog without saving changes, click Cancel.
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Mapping Rate Codes Between Rate Schedules 




The Interschedule Mapping Table defines "equivalencies" between rate codes in different rate schedules. This features makes it possible to substitute the "best" rate code for a customer when comparing different rate schedules, such as when applying Oracle Utilities Rate Management's Customer Impact Analysis or Oracle Utilities Billing Component's Trial Bill Calculation. 
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Browsing and Viewing Account Data 




From time to time , you might need to verify account data in the Oracle Utilities Data Repository. This can include checking Bill History records, or the specific rate forms associated with a given account. Oracle Utilities applications include methods for viewing data using Data Manager's Browser and Account Centric View. Each of these is described below. 




How to Browse Account Data: 


1.Select  File-›Browse Customer/Account(s)...






The  View Customer/Account(s) Inputs dialog box appears.








		

2.




		



Complete the dialog as follows: 



















Select By:   Choose either Account or Customer.






Select:   Select the accounts or customers of interest using one of the following options:








		

•




		





ID -  Type the ID of the customer or account of interest.





















		

•




		





List -  Select the list of interest. (See Chapter Eleven in the Data Manager User's Guide for information about creating lists.)





















		

•




		





All -  View all customers or accounts in the database.





















		

•




		





File -  Select a file containing a list of customer/account IDs (*.IDS), a list file (*.lst), an account query file (*.qra), or a customer query file (*.qrc).





















		

3.




		



Click  OK. The Browse Customer/Account(s) window opens, with just the selected customer or account records displayed.

















Additional information about using the Browser can be found in  Chapter Six: Browsing Data in the Data Manager User's Guide.




Viewing Account Data: 








		

1.




		



Select  File-›View-›Account.

















The  Enter Account ID window appears.








		

2.




		



Enter the ID for the account you wish to view, and click  OK.

















The  View Account window appears, with information about the selected account displayed. The View has two sections.  The top section displays the "header" or "indicative" data.  This data remains on the screen for easy reference while you work with the account information displayed in the various tabs below.  For instance, if you're on the phone with a customer researching his or her bills, the customer's name is always visible at the top of the screen.




Each tab in the lower portion of the screen is devoted to a particular category of information.  To view the contents of a tab page, simply click on its tab. 




The tabs are organized in four columns.  The fields displayed on each tab page are detailed in the last section of this chapter. 






Note:  The specific tabs and fields in your company's version of the Account-Centric View may differ from those shown in the illustration below.




Additional information about using the Account Centric View can be found in  Chapter Five: The Account-Centric View in the Data Manager User's Guide.
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User Files 




The User Files tab specifies where files created by the user are stored by the system. 






Default User Directory:  If there is a value in this field it will override the USERDIR setting in the configuration file (after the database is opened). Files put in the user directory before the database is opened - such as .log files - will still be placed in the USERDIR directory. 






Use last save/open path as default for next save/open?  - If this checkbox is checked, the path used in the last open or save operation will be the default path for the next open and save operation, for the duration of the application's run. Each time an application starts it will use the Default User Directory/USERDIR path in the first open or save.
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Error Handling 




The Error Handling tab specifies how errors are handled by the system. 






Display error messages:   If checked, the program will display the number of errors (if any) it encountered during the job run.






Stop analysis after ## errors:   The number of errors to allow when running an analysis or bill.






On Rules Language Interval Data Error:   Use this option to specify how the programs handle interval data problems encountered while the rate schedule is running:








		

•




		





Stop with Error.   Stop processing in any mode.





















		

•




		





Log Message.   Complete processing; include warning message in error log, but not in report.





















		

•




		





Continue.   Complete processing; do not issue any messages.





















		

•




		





Issue Warning Message.   In the Automatic Billing mode, stop processing the bill.  In the Automatic or Approval Required modes, complete processing, but issue a warning message in the bill report.





















		

•




		





Issue Information Message.   Complete processing; include informational message in report.
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Interval Data Merge 




The Interval Data Merge tab allows you to specific how interval data cuts are merged when using the INTDJOIN Rules Language function. 






Note : The Interval Data Merge options tab only appears if you include the INTD_NEW_JOIN parameter in the configuration file. See the Oracle Utilities Energy Information Platform Installation and Configuration Guide for more information.






Check Interval Data Validation before Merge:  Check this checkbox to cause the program to check cuts' merge validation flag before merging. The default is not to check.






Interval Data Merge Selection Criterion:  Choose a criterion for merging overlapping interval cuts (i.e., a rule how to merge two cuts into one). There are four criteria for merge: 








		

•




		





Most Recent Start:  Pick the interval from the cut that starts later.





















		

•




		





Best Status:  Pick the interval from the cut with a better status code. If the intervals have the same status code, the values are averaged.





















		

•




		





Average Value:  Pick the time-weighted average of the overlapping intervals. The status code of the averaged interval will be the worse of the overlapping intervals.





















		

•




		





Maximum Value:  Pick the interval from the cut with a larger value.





















		

•




		





Time Stamp : Pick the interval from the cut with the later Timestamp.

















The default criterion is Most Recent Start. 
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Interval Data Options 




The Interval Data Options tab specifies how interval data is loaded and processed by the system. 






Exclude intervals with quality less than:  Specify a status code level that the interval data must meet or exceed in order to be included in the calculations.  All interval values with a code less than your selection will be ignored by the programs.




The codes are listed in order of decreasing quality—alpha codes generally indicate that the data is acceptable; numeric codes indicate that the data is suspect and should be corrected.. 








		



Status Code 




		



 Classification of interval data 










		





(blank) 






		



Normal 










		



A 




		



Normal, alternate-recorded (e.g., hand-entered) 










		



J 




		



Data inserted by Oracle Utilities Load Analysis to correct outage 










		



L 




		



Default for data modified by Oracle Utilities Load Analysis Load Data Editor 










		



M 




		



Splice peak interval (estimated value) 










		



N 




		



Interruptible or curtailable load 










		



P 




		



Inserted outage 










		



Q 




		



Corrected outage 










		



X 




		



Cuts resulting from merging invalid data or from unrecognized status codes 










		



Y 




		



Reserved 










		



1 




		



Uncorrected outage 










		



2 




		



Non-normal (usually timing-pulse defects) 










		



5 




		



Aggregated interval used in rolling format with partially missing or unavailable data 










		



7 




		



Marged, aggregated, or transformed interval with partially missing data 










		



9 




		



Missing 
















Day Start:   Specify the time that your facility considers the beginning of the day—8:00 am or midnight.  This setting pertains to the ROUNDATE Rules Language function.






Use in all day calculations:   Check this box if you want the Day Start time to apply to all date calculations that round to a full day or higher.






Use interval end time when displaying time of the interval:   Specifies whether the start- or end-times of intervals are displayed for the MAXDATE values in INTDVALUE and INTDTOUVALUE functions. If checked, the end-time is displayed.  If unchecked, the start-time is displayed (the default).






Add Fall Daylight Savings Time value to Energy requests:   Because previous versions of the Oracle Utilities Data Repository stored energy in a 24-hour format, the system had to compensate for the extra hour of interval data that is left over on the day when the clocks are turned back for Daylight Savings Time. To do this, the system automatically takes each account's interval data values for the two DST hours (2:00 AM in the US) and averages them together for a single hour. This option enables you to specify how Oracle Utilities Billing Component (or other Oracle Utilities products) handles the "leftover" hour when calculating energy from interval data.  If this option is checked, the system doubles the averaged value. If the option is unchecked, it uses just the single, averaged value. This option should only be used if the DST Participant flag is set to "A" in your interval data.




Version 3.70 (and above) can store interval data in 25-hour format (for the day when DST ends). Oracle recommends this option remain  unchecked when using version 3.70 or above. Enabling this option in version 3.70 or above can result in incorrect energy calculations.






Export Validation Flag:  Controls the settings of the Validate_Record_Flag upon export. This can be set to one of the following:








		

•




		





Valid  (default): Sets all Validate_Record_Flags of each cut within the exported file to "N", ignoring the Validation status of the requested cuts.





















		

•




		





Invalid : Sets all Validate_Record_Flags of each cut within the exported file to "Y", effectively ignoring the Validation status of the requested cuts.





















		

•




		





Use Cut's Status : Sets the Validate_Record_Flag to either "Y" or "N" depending upon the combination of validation flags that are current in the cut when exporting takes place. If either the Merge flag or the Internal_Validation flag are "Y", then the Validate_Record_Flag in the exported cut is set to "N".  If both are set to "N" then the Validate_Record_Flag is set to "Y". 
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Interval Data Source 




The Interval Data Source tab specifies the source of interval data used by the system. 






Interval Data Database:   Select a Type from the three options:








		

•




		





File:  Specify an interval data file. The File option below becomes active when this button is selected, allowing you to specify a file (and path) in the File Name field, or to Browse to a file.





















		

•




		





Default:  Specifies that the default Interval Data Database identified in the LODESTAR.CFG File be used. See the Oracle Utilities Energy Information Platform Installation and Configuration Guide for more information about setting a default Interval Data Database.





















		

•




		





Customer Database:  Specifies that interval data stored in the Oracle Utilities Data Repository be used. When this button is selected, a drop-down list appears listing all available interval data header tables. The default table is the Channel Cut Header (LSCHANNELCUTHEADER) table. 



















Export Records Overwritten by SAVE to File:   This option saves interval data cuts from the Interval Database to an export file before they are overwritten by new cuts created by a Rules Language SAVE Statement.  The full path and name of the file (including a valid extension) must be specified.




This option appends new cuts to the same file without overwriting previously exported cuts. 
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Billing Options 




The Billing tab specifies how billing information is displayed by the system. 






Round Revenue:  Specifies the precision of revenue values in reports.  This setting affects only values that have been assigned to revenue identifiers via an Assignment, All, or Block statement in the applicable rate form.  A value of 0 (zero) means don't round, -1 means round to dollars, -2 means round to tens of dollars, 1 to tens of cents, 2 to cents, and so on.






Currency displayed to n decimal places:  Specifies the number of decimal places shown in reports for dollar values. It is usually set to be consistent with your choice for Round Revenue. A value of 0 (zero) means use the default (display cents), 1 means display tens of cents, 2 means display cents, 3 means display tenths of cents, 4 means display hundredths of cents, and so on.






Note : This setting applies only to Oracle Utilities Billing Component reports; Oracle Utilities Rate Management reports always display dollars with two decimal places (cents).






Billing Units displayed to n decimal places : Specifies the number of decimal places shown in reports for billing units.






Display midnight as 00:00:00 (not blank):  Specifies whether or not a value (00:00:00) is displayed and printed when the time is midnight or unspecified.




If you leave this option unchecked (the default), the programs print and display the date without a time when  either the time has not been specified or the time is midnight. For example, if either 12/01/1998 or 12/01/1998 00:00:00 were specified, the program would display 12/01/1998.




If you check this option, the programs print and display 00:00:00 when the time is either unspecified or midnight. For example, if either 12/01/1998 or 12/01/1998 00:00:00 were specified, the program would display12/01/1998 00:00:00. 
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Setting Up Oracle Utilities Rate Management to run in Batch Mode 




This chapter describes how to set up Oracle Utilities Rate Management to run in batch mode, including: 








		

•




		





Customer Impact 

























		

•




		





Customer Revenue 

























		

•




		





Bill Frequency 

























		

•




		





Typical Bill 

























		

•




		





Crossing Point 

























		

•




		





Hours Use Matrix 
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Customer Impact 




You can run Customer Impact in batch mode using the CUSTIMPACT.EXE command line program. 
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Mapping Rate Codes 




How to map a Rate Code: 








		

1.




		



Select  File-›Browse-›Customer Database.

















The Browser appears. 








		

2.




		



Using the  right mouse button, click the Inter-Schedule Mappings Table and the select Insert New.

















A blank data entry form appears in the right pane. 








		

3.




		



Complete the form: 



















Rate Code:   Click anywhere in this field to make the Select Rate Code list appear.




This is a list of all rate schedules and rate codes currently stored in the Oracle Utilities Data Repository. If the list is very long, you can use the search tools at the top of the window to locate the desired rate code. 




Highlight the desired rate schedule/rate code and click  OK. Your selection appears in the Browser's data entry form.






Mapped Rate Code:   This is the Rate Code you want to map to the first rate schedule/rate code selection. Use the same process as described above.








		

4.




		



To save the mapping, select  Edit-›Add, or click the right mouse button and select Add.



















Note:  Your new mapping appears in the left pane of the Browser.








		

5.




		



Repeat steps 2 through 4 for as many mappings as you wish to create. When you have finished, click  File-›Close.
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Reporting or Graphing a Bill Frequency Table 




This feature allows you to examine the contents of a Bill Frequency Table (.bft file). Specifically, it creates a multi-paged report, with each page showing the breakdown for one determinant, bill month, and (optionally) rate code group. Following the monthly values, the report shows the results for the entire period, broken down by Rate Code Group. Finally, the last page in the report displays the "grand total summary" for the entire test period for all customers in the table. 




In addition to creating tabular reports, you can also graph data. See  

How to create a graph:

 for more information.




How to create a report: 








		

1.




		



At the Oracle Utilities Rate Management desktop, select  Analysis-›Bill Frequency-›Analysis.

















The  Bill Frequency Analysis Inputs dialog box appears.








		

2.




		



Complete the dialog as follows: 



















Bill Frequency Table:  Select the desired Bill Frequency Table.






Test Period From/To:  Specify the range of months that you want to report.






Report Options:   Click this button to modify the report.  In the dialog that appears, you can:








		

•




		



Disable the monthly reports so that only the grand summary total is reported or graphed (check  Display summaries only).





















		

•




		



Add up to three optional titles to appear at the top of the report. 





















		

•




		



Write the report directly to a file (no display is produced). 





















		

3.




		



In the  Bill Frequency Analysis Inputs dialog, click Report.

















The report window appears (unless you selected  Write report directly to file in the Report Options dialog).   The section 

About the Bill Frequency Analysis Report Format

 explains each of the columns in the report.




You can now print or export the graph using options under the  File menu.  If you decide that you want to graph the data, select View-›Graph.  Go to step 4 in the next set of instructions.




How to create a graph: 




This option not only allows you to create graphs of selected data from the Bill Frequency Table, but also automatically creates a tabular report in a minimized window. 








		

1.




		



At the Oracle Utilities Rate Management desktop, select  Analysis-›Bill Frequency-›Analysis.

















The Bill Frequency Analysis Inputs dialog box appears. 








		

2.




		



Complete the dialog as follows: 



















Bill Frequency Table:  Select the desired Bill Frequency Table.






Test Period From/To:  Specify the range of months that you want to graph.






Report Options:  Click this button to control the amount of data that is processed. Specifically, you can disable the monthly reports so that only the grand summary totals are processed. To do this, place a checkmark next to Display summaries only.






Note:  Do not

select either of the options Disable graphing of data or Write report directly to file. Be sure that Keep data

is checked. If you add optional titles, only the first (Title 1) will appear on the graph.








		

3.




		



In the Bill Frequency Analysis Input dialog, click  Graph.

















The  Create Graph From Columns dialog appears.








		

4.




		



Complete the dialog as follows. 



















Select x-axis column:  Select a report column variable to serve as the x-axis (see the next section, About the Bill Frequency Analysis Report Format, for a description of the columns).






Select column:  Select a report column variable to serve as the y-axis (see the next section, "About the Bill Frequency Analysis Report Format," for a description of the columns).






Select RC, Bill Month to Graph:  Select a rate code group and bill month to graph.




Click the  Add button to move the pair into the Pairs to Graph list box. You can select up to 12 pairs to include on one graph.








		

5.




		



Enter an optional title for the graph, and click  OK to close the dialog and create the graph and report.





















		

6.




		



If desired, you can change the graph's background color by selecting View-›Background Color. In addition, you can save the graph image in a .gif or .met file using the File-›Save As option.
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Creating a Bill Frequency Table 




Once you have created and stored the blocking(s), you are ready to create the Bill Frequency Table. 






Note:  You can have a different blocking for each determinant in the Bill Frequency Table.




How to create a Bill Frequency Table: 








		

1.




		



At the Oracle Utilities Rate Management desktop, select  Analysis-›Bill Frequency-›Create.

















The  Create Bill Frequency Table dialog box appears.








		

2.




		



Select either  Account or Customer in the Select By box.





















		

3.




		





Select  the accounts or customers of interest using one of the following options:





















		

•




		





ID:   Type the ID of the account or customer of interest.





















		

•




		





List:  Select the list that contains the IDs of the customers or accounts whose usage you want to use as the basis for the Bill Frequency Table. If the contents of the list may have changed since the last time that the query associated with it was run, check Refresh list before using. This option updates the list for this job and saves the new version of the list to the database, replacing the old version.





















		

•




		





All:  Select this option to include all customers or accounts that are in the Customer Database.





















		

•




		





File -  Select a file containing a list of customer/account IDs (*.IDS), a list file (*.lst), an account query file (*.qra), or a customer query file (*.qrc).





















		

4.




		



Specify the  Test Period.Enter a range of months that defines the test period.





















		

5.




		



Select the  Determinant/Blocking. In the Determinant list box, highlight a desired billing determinant. Then, in the Blocking list box, highlight the Blocking you wish to apply to the selected determinant. Click Add to put the results in the Determinant/Block Pairs list box. Repeat for each billing determinant you want to include in the Bill Frequency Table.





















		

6.




		



Click  Advanced if you want to break down the Bill Frequency Table by Rate Code Groups. If so, go to Step 4. If not, click OK and go to Step 6. (If you do not apply the Advanced option, Oracle Utilities Rate Management will automatically default to a single Rate Code Group, which will consist of all Rate Codes assigned to all customers in the Bill Frequency Table.)





















		

7.




		



If you clicked  Advanced, the Advanced Create Bill Frequency Table dialog box (shown above) will appear. This dialog lets you summarize billing information in a Bill Frequency Table by Rate Code Group. This is useful when you are using a Bill Frequency Table to compute revenue for a rate schedule with statements dependent on a customer's rate code. Complete the box as follows:





















		

•




		



Select a Rate Schedule in the  Rate Schedule combo box.  All Rate Codes for the selected Rate Schedule then appear in the Rate Codes list box.





















		

•




		



Select one or more rate codes from the  Rate Codes list box to define a single Rate Code Group (you must hold down the Shift key to highlight more than one rate code).





















		

•




		



When you have highlighted all members of the group in the  Rate Codes list box, click Add.  They appear in the Rate Code Groups list box.





















		

•




		



In the  Select First Rate Code list box, highlight one code in the group. Oracle Utilities Rate Management will use this code to represent the group in later displays and reports, and more importantly will apply it to all customer data that falls within this group during the revenue analysis. If you do not explicitly highlight a code, the program uses the first one in the list by default.





















		

•




		



Repeat the above four steps for each desired rate code group. 





















		

8.




		



Click  OK to accept the defined Rate Code Groups.





















		

9.




		



When you are satisfied with your options in the Create Bill Frequency Table dialog box, click  OK.  The system will prompt you for a name (up to 8 characters).

















A Progress Indicator dialog appears and tracks the progress of the Bill Frequency Table creation. If you want to stop the process for some reason, click  Abort.




At the end, the application creates a file with the extension .BFT and puts it in the LODESTAR\RCDATA directory (e.g., C:\LODESTAR\RCDATA\freqtab.bft). You can now examine and analyze the contents of the file by applying the Bill Frequency Analysis feature (described next). 
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Creating a New Blocking 




When you create a blocking, you can specify the high and low values that define each individual block. Or, if all or a portion of the blocking consists of a series of contiguous, equal-size blocks, the software gives you a shortcut—in that case, you can supply the high and low values that define the range covered by the series of equal-sized blocks, and then the value of the block (called the " Step" value).




How to create a new blocking: 








		

1.




		



Go to the Data Manager desktop. If you are at the Oracle Utilities Rate Management desktop, you can open Data Manager by selecting  Tools-›Data Manager.





















		

2.




		



At the Data Manager desktop, select  File-›Setup-›Blocking Tables.

















The  Open Blocking dialog box appears.








		

3.




		



Click  New.

















The  Blocking dialog box appears.








		

4.




		



Under  Values, enter the Low and High values for the current block (or the range of contiguous, equal-size blocks). The High value must be greater than the Low value for each block, except for the last block in the blocking, which may be zero (a High value of zero indicates infinity).

















You can specify negative numbers for the low and high values that define a block (however, these are used only in the Billing Impact Frequency report in Customer Impact). If you change your mind and want to remove a minus sign, simply type a + sign in the Values field for that value. 








		

5.




		



Enter a  Step value for the block. If you are defining each block individually, then the Step value must equal the difference between the High and Low values. If you are using the step feature to specify a set of contiguous, equal-size blocks, the Step value must evenly divide into the difference between the High and Low values. If you are specifying the last block with a High value of 0, the Step value should be 0, too.



















Note:  If any usage values fall outside of the specified blockings (either at the high end if you did not specify 0 for the High value in the last block, or at the low end if there are negative values), the program automatically creates an "additional" blocking at that end when the program creates the Bill Frequency Table.








		

6.




		



Click  Add to insert the block(s) into the Blocking Contents list box. A block is automatically inserted into its proper position in the list box based on its Low and High values.





















		

7.




		



Repeat Steps 3 through 6 to add any other blocks necessary to complete the definition of the Blocking.  Make sure that the High values match the Low values for consecutive blocks.























		

8.




		



Click  OK to save the new blocking in the Customer Database. The Save

Blocking Table As dialog appears.





















		

9.




		



Enter a name and comments for the blocking, and click  OK.

















You can also open an existing blocking file. 




How to Open an Existing Blocking: 








		

1.




		



At the Data Manager desktop, select  File-›Setup-›Blocking Tables.

















The  Open Blocking dialog box appears.








		

2.




		



Select the desired blocking and click  Open. You can also import a Common Blocking file by clicking Import and selecting the appropriate Common Blocking file. The imported blocking file then appears in the Open Blocking dialog.





















OEBPS/Text/part0055.xhtml






Bill Frequency Table Description 




A Bill Frequency Table is a summary of billing determinant data for a customer list over a range of months. For each month, data for one or more determinants is grouped into Blockings which are in turn (optionally) grouped by one or more rate code groups. 




Blockings 




Data for each determinant of interest is collected into "bins" or "blocks" which each represent a continuous range of possible billing determinant values. A series of contiguous blocks comprises a "blocking" which serves to partition the entire range of possible billing determinant values. Each determinant summarized by the Bill Frequency Table is paired with a selected blocking to form a Determinant/Block pair (each determinant may have a different blocking). Each block maintains a customer count and a total value. When a customer's billing determinant value falls within a given block the customer count or the block is incremented and the billing determinant value is added to the block's total value. The result is a table of counts and total usage for each range in the blocking. 




Rate Code Groups 




The data in a Bill Frequency Table can be further separated out into one or more Rate Code Groups.  A Rate Code Group is simply a list of one or more rate codes.  The default Rate Code Group for a Bill Frequency Table consists of the set of all rate codes assigned to customers in the analysis population.  A Rate Code Group is identified by the first rate code in the list.  Within a single Bill Frequency Table, no two Rate Code Groups may contain the same rate code.  A customer's billing determinant data will be included within a Rate Code Group only if that customer's assigned rate code is in the Rate Code Group. 




Bill Frequency Table Files 




Each Bill Frequency Table is stored in a separate ASCII text file. These files are located in the RCDATA directory and have a .BFT extension. These files are automatically created by the tools provided by Oracle Utilities Rate Management and should not be manually edited under normal circumstances. 
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Required Inputs for Creating Bill Frequency Tables 




Minimally, Bill Frequency Table creation requires a list of the customers that you wish to summarize data for, bill determinant values for the customers for the desired test period, and at least one Bill Determinant/Blocking pair. 




Blockings are created separately from Bill Frequency tables and are stored in the Oracle Utilities Data Repository. Blockings may be subsequently edited after initial creation. Bill Frequency tables cannot be edited after creation. Both Blockings and Bill Frequency tables may be deleted from the database. Instructions for creating Blockings and Bill Frequency tables are provided in this chapter. 
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Purpose of Bill Frequency Tables and Analysis 




Bill Frequency Tables are used to summarize billing determinant data for a user-defined group of customers. You can then apply rate schedules to these tables for revenue analysis (using Oracle Utilities Rate Management) or revenue forecasting (using Oracle Utilities Rate Management - Revenue Forecasting). 




Prior to running the revenue analysis or forecast, you may wish to analyze the contents of the Bill Frequency Table itself using Oracle Utilities Rate Management's Bill Frequency Analysis. This feature displays the contents of the table in tabular and/or graph format. Bill Frequency can also be run in batch mode using a command line program. For more information, see  

Bill Frequency

 of 

Appendix B

: 

Setting Up Oracle Utilities Rate Management to run in Batch Mode

.
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Creating Bill Frequency Tables, Reports, and Revenue Analyses 




This chapter explains how to create and analyze Bill Frequency Tables using tools provided by Oracle Utilities Rate Management and Data Manager. Once you have created a Bill Frequency Table, you can then generate revenue reports by applying a selected rate form to the usage data summarized in the Bill Frequency Table. This chapter includes: 








		

•




		





Purpose of Bill Frequency Tables and Analysis 

























		

•




		





Creating a New Blocking 

























		

•




		





Creating a Bill Frequency Table 

























		

•




		





Reporting or Graphing a Bill Frequency Table 

























		

•




		





Creating a Bill Frequency Revenue Analysis 

























OEBPS/Text/part0051.xhtml






Oracle Utilities Rate Management Documentation Overview 




In addition to the  Oracle Utilities Rate Management User's Guide (this book), Oracle Utilities Rate Management also comes with a number of other manuals and documents. These are described briefly below.




Oracle Utilities Energy Information Platform User' Guide 




The  Oracle Utilities Energy Information Platform User's Guide contains describes how you work with the Oracle Utilities Energy Information Platform web -user interface.




Data Manager User's Guide 




Data Manager is the tool you use to view, edit, and update records in the Oracle Utilities Data Repository. The  Data Manager User's Guide explains how to use Data Manager to view and maintain data in the Oracle Utilities Data Repository. 




Oracle Utilities Rules Language 




The Oracle Utilities Rules Language is a powerful command language that defines business rules and specific items such as rate tariffs. The  Oracle Utilities Rules Language User's Guide and Oracle Utilities Rules Language Reference Guide describe the Oracle Utilities Rules Language and how it is used with Oracle Utilities products.




Oracle Utilities Energy Information Platform Installation Guide 




The  Oracle Utilities Energy Information Platform Installation Guide contains installation information related to the Oracle Utilities Energy Information Platform.




Oracle Utilities Energy Information Platform Configuration Guide 




The  Oracle Utilities Energy Information Platform Configuration Guide contains configuration and system administration information related to the Oracle Utilities Energy Information Platform.
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Database Support 




In addition to the LSCurrency table and related columns in the Account, Journal Account, and Checking Account tables, database support for internationalization includes the addition of the COUNTRY column in the Address table and the change from ZIP Code to Postal Code on user interfaces. 
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File Formats 




Input/Output File Formats 




Numbers and date/times in input and output files (such as files used with the PLIMPORT program) are independent from locale settings. 




Non-English characters are supported in input/output files. 




XML Formats 




All dates, times, and numbers contained in XML files are represented using the standard formatting rules as defined by the W3C XML Schema Recommendation. For backward compatibility, previously accepted formats for dates and times will continue to be accepted on input, however, all output will use the XML Schema representation. 






Note : XML files created by the SAVE TO XML Rules Language statement are  an exception. The date, time, and number formats in Rules Language generated XML files are based on the Rules Language configuration used to create them.




Non-English characters are supported in XML files 
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Multiple Currency Support 




Multiple Currency Support allows for accounts with different associated currencies. This is accomplished through the presence of the Currency Code column on the Account, Journal Account, and Checking Account tables in the Oracle Utilities Data Repository. This column references records in the LSCurrency table 




Multiple Currency and Oracle Utilities Receivables Component 




All input screens which have amount fields on them indicate what currency type is expected as input. 




All elements that represent a currency in Oracle Utilities Receivables Component XML structures have a CURRENCY attribute that indicates the corresponding currency type for the amount. The string values used for this attribute are the same as the Currency Code values in the LSCurrency table. On output, the CURRENCY attribute is set for the account as specified in the database. If the account's currency type is not specified in the database, the default currency is used. 




A CURRENCY attribute (using the standard stem.tail notation) is supported for Oracle Utilities Receivables Component transaction identifiers to specify the currency type for the account. 




On input, the CURRENCY attribute of all Oracle Utilities Receivables Component transactions is checked against the currency value of the account against which the transaction is being posted using the following rules: 








		

1.




		



If a currency type is specified for the account in the database, the transaction must indicate the same currency type or it is an error. 





















		

2.




		



If a currency type is not specified for the account in the database, the transaction must indicate either no specific currency type or the default currency type for the database or it is an error. 

















All transactions that involve two or more accounts (such as Payment and Balance Transfers) validate that the currency types are the same for each account (no currency translation will occur). The credit/debit account pairs for each journal translation record are validated to ensure that they both have the same currency type. Only journal translation records that have credit/debit accounts with the same currency type as the account against which the transaction is being posted are used. Additional currency validations occur for payment files and refund checks. 




Multiple Currency and Oracle Utilities Receivables Component Reports 




Where applicable, Oracle Utilities Receivables Component reports are grouped by Currency Code. 




Multiple Currency and Other Oracle Utilities Products 




Oracle Utilities Billing Component, Oracle Utilities Rate Management and Data Manager reports display the Currency Code associated with each account where applicable. Reports that contain multiple currency types do not include the Summary Results page. 




In Oracle Utilities Rate Management - Revenue Forecasting, the default currency type is used for all presentation of currency amounts, regardless of whether or not a specific currency has been indicated in the database for any accounts. 
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Currency Presentation 




Currency information is stored in the LSCurrency table in the Oracle Utilities Data Repository. This table contains one or more currencies, each defined by a currency code, currency symbol, and formatting rules (such as the number of decimal places). Currency codes in this table use ISO-4217 codes. The LSCurrency table also indicates the Default currency for the database. See  LSCurrency on page 3-3 in the Oracle Utilities Energy Information Platform Configuration Guide for more information about setting up the LSCurrency table.






Note : Although records in the LSCurrency table are not required, Oracle Utilities strongly recommends that at least one record with all properties specified be created and set as "Default". This will ensure consistent display of currency information.




Currency Presentation in Oracle Utilities Receivables Component and Oracle Utilities Quotations Management 




Currency input and display is identical to that for numbers with two exceptions:  








		

•




		



A currency indicator is also displayed next to currency input controls and currency displays. The specific currency symbol displayed and the manner in which currency is formatted are determined in the following order: 





















		

a.




		



The currency associated with the account being viewed (from the LSCurrency field in the Account table). 





















		

b.




		



The default currency in the LSCurrency table. If there is no default currency, the first record in the LSCurrency table (sorted alpha-numerically by Currency Code). 





















		

b.




		



If the LSCurrency table is not present or does not contain any records, the currency and formatting of the Server System Locale (defined by the operating system installed on the web server),specified in the  HKEY_USERS\.DEFAULT\Control Panel\International key in the Windows Registry on the web server.





















		

•




		



Currency formatting rules for the user's selected locale are overridden if specific formatting rules for the currency are stored in the LSCurrency table. Typically, the only formatting rules that would be overridden at the currency level would be the ISO code, symbol, and number of decimal places. This applies to Oracle Utilities Receivables Component reports as well, except that the initial locale formatting rules come from the regional settings of the machine on which the report is run. 

















Currency Presentation in Other Web-enabled Products 




Currently, other web-enabled products do not require input of currency values. 




Display of currencies is based on the formatting of the selected locale and of the default currency in the database (currency specific formatting always overrides locale specific formatting). 




Enabling Display of International Currency Symbols 




Display of international currency symbols requires the appropriate Encoding option is selected on Internet Explorer. 




How to select encoding options: 








		

1.




		



Select  View-›Encoding from the Internet Explorer menu bar.





















		

2.




		



Select the appropriate option from the list. For example, to enable displaying of the Euro symbol and other Western European currency symbols, select the  Western European (Windows) option.

















Currency Presentation in Client/Server Products 




Client/server products do not require input of currency values. 




Display of currencies is based on the formatting of the client machine's regional settings and of the default currency in the database. Currency specific formatting always overrides locale specific formatting. If the default currency in the database does not specify any formatting, the currency symbol is used for formatting. If the currency table does not exist or does not contain any records then the default currency is determined by the Regional Settings on the client/server machine. This applies to reports as well. 
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Date and Numeric Presentation 




The display and input of dates and numbers is based on the selected locale. 




Web-enabled products 




Display formatting of both numbers and date/times is based on the user's selected locale. 




Copy, cut, and paste operations are supported for all input controls. Required fields are identified by asterisks. Null values are represented by blank (empty) controls. Moving the mouse pointer over an input area displays sample formatting for that field. 




Number input controls only accept formatting based on the user's selected locale. The only allowable characters include digits, decimal separator, and minus sign. Any other characters are filtered from input. 




Date input controls only accept formatting based on the user's selected locale. Dates can either be keyed in or selected from a pop-up calendar control. All times are keyed in and based on 24 hour format (no AM or PM indicator). 




Input validation occurs upon data entry. 




Client/Server Products 




Formatting for numbers and date/times is based on the locale determined by the regional settings of the client and/or application server machine. Date/time formatting can be overridden from the General Options tab of the Default Options dialog. 




Reports 




Display formatting of both numbers and date/times for reports is based on the Server System Locale on the machine on which the reports are run. 
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Locales and Languages 




Two fundamental concepts underlying international support in Oracle Utilities applications are  languages and



locales. Languages determine the specific language in which text labels and controls of an application appear. Locales determine the specific region or country in which the user is working. Specifically, locales are used to specify display and input formatting for:








		

•




		



Date/time and numeric presentation, and 





















		

•




		



Currency presentation 

















How a user selects a language and/or locale is determined by the type of application being used. 




Web-enabled Products 




For web-enabled products, a user's locale and language are selected from the  Locales tab of the Set Preferences screen. The selected locale and language are stored in the user's security properties. The available locales on this screen are specified in the LOCALES.CFG.XML configuration file (see Chapter 2: Configuration Files in the Oracle Utilities Energy Information Platform Configuration Guide for more information). Locales included in the LOCALES.CFG.XML file must also be installed on the web server and be accessible from the Regional Settings Control Panel. If a selected locale is not installed on the web server, currency formatting and presentation may be incorrect.




If a user does not select a locale (or selects a locale of "None"), the default locale is the Server System Locale (defined by the operating system installed on the web server). Oracle Utilities recommends that all users specify a locale before using internationalized applications. 




Client/Server Products 




For client/server products, the user's locale is determined by the Regional Settings of the client and/or application server machine. 




Languages 




The language for client/server products is specified using a command line switch and/or a parameter in the LODESTAR.CFG file. See  Oracle Utilities Application Command Line Parameters on page 4-11 in the Oracle Utilities Energy Information Platform Installation Guide for more information about command line parameters. See LODESTAR.CFG on page 2-2 in the Oracle Utilities Energy Information Platform Configuration Guide for more information about the LODESTAR.CFG file. At this time, available languages include English, French, German, and Italian.




Reports 




For client/server applications, the locale for reports is determined by the Regional Settings of the machine on which the report is run. 




For web-enabled applications, the locale for reports is based on the Server System Locale (defined by the operating system installed on the web server) 




Languages 




For client/server applications, the language that appears on reports is determined by the language of the application that generated the report, specified either by a command line parameter or a configuration file parameter. 




For web-enabled applications, the language is specified by the Regional Settings  of the machine on which the report is run, unless overridden by the LANGUAGE parameter in the LODESTAR.CFG file. 
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International and Multiple Currency Support 




This section outlines international and multiple currency support in the Oracle Utilities Energy Information Platform, including: 








		

•




		





Locales and Languages 

























		

•




		





Date and Numeric Presentation 

























		

•




		





Currency Presentation 

























		

•




		





Multiple Currency Support 

























		

•




		





File Formats 

























		

•




		





Database Support 
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Important Note 




Before you can use Oracle Utilities Rate Management or any of its functions, you must first make sure that appropriate data and records have been created in the Oracle Utilities Data Repository. The instructions in this manual assume that these records exist. For more information about creating, updating, or editing records in the Oracle Utilities Data Repository, please refer to the  Data Manager User's Guide.
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Saving and Applying Settings for Dialog Boxes 




This section describes a very convenient and time-saving feature that enables you to save input parameters for tasks you perform frequently. Specifically, you can save your selections for account/customer and date(s). To use this feature, complete an input dialog box as you would normally before running a billing, analysis, or reporting module, save the settings with a name of your choosing, and recall them the next time you want to perform the same or a similar task. 




How to save settings: 








		

1.




		



With the desired setting specified in an input dialog box,  right-click in any blank area of the dialog. The Save/Restore dialog box appears.





















		

2.




		



Enter a name and optional descriptive note for your settings, and click  Save.

















The settings are now saved to the database. 




How to import/export settings: 






To export: 










		

1.




		



Select the report settings and click  Export. The Select File for Dialog Settings Report dialog opens.





















		

2.




		



Navigate to the desired directory and click  Save. The report settings are exported in XML format, and can now be imported for use with other dialogs.



















To Import: 










		

1.




		



Click  Import. The Select File for Dialog Settings Report dialog opens.





















		

2.




		



Select the desired file and click  Open. The report settings are now available for use with the current dialog.

















How to apply the settings: 








		

1.




		



Open the dialog box for which you've saved settings.  Right-click in any blank area of the dialog.  The Save/Restore dialog appears.





















		

2.




		



Select the desired settings and click  Restore.

















The dialog is updated with the settings.  You can use them as is, or modify them before running the job. 




How to delete the settings from the database: 




The following instructions explain how to delete unwanted settings, so that they no longer appear in the pop-up menu.  You can delete reports by highlighting the report settings you wish to delete and clicking  Delete or by deleting the settings from the Data Repository using the Browser. To delete report settings using the Browser, using the following procedure.








		

1.




		



Select  File-›Browse-›Customer Database. The Browser opens.





















		

2.




		



Click on the plus sign that appears to the left of the  Report Settings table icon (you may have to scroll down the tree to bring that table icon into view).

















A list of the Report Setting records that are currently stored in the database appears under the table icon. Each report setting record is identified by a combination of three IDs: the logon ID of the user that saved the setting, the internal ID that identifies the dialog box to the system, and the name that the user assigned to the settings when he/she saved them. 








		

3.




		



Highlight the icon for the record you wish to delete. 





















		

4.




		



Select  Edit-›Delete from the menu bar.

















A message box appears, asking you to confirm that you wish to delete the record.  Click  OK to delete the record. Click Cancel to keep it.
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Copying Text Between Windows 




This is another timesaving tip that enables you to copy information from one text entry field and paste it into another, saving you the effort of retyping the data and ensuring that it is the same.  It is especially useful for Account IDs.  The fields can be in the same or different windows. 






How to copy text from one data entry field and paste it into another: 










		

1.




		



Highlight the desired text, and  with the I-beam cursor still positioned in the text field, click the right mouse button.

















A menu appears. 








		

2.




		



Select  Copy.

















The text is now saved to the Clipboard. 








		

3.




		



Go to the window containing the field in which you wish to paste the text. 





















		

4.




		



Click the cursor in the desired field.  Without moving the cursor out of the field, click the  right mouse button.  When the menu appears, click Paste.  The text appears in the field.

















Alternate approach: 




Here is another method that does the same thing, but with the keyboard instead of the mouse. 








		

1.




		



Highlight the desired text in a text entry field.  Do not move the cursor out of the text field. 





















		

2.




		



Press  Ctrl+Insert (or Ctrl+C) on your keyboard.





















		

3.




		



Go to the window containing the field in which you wish to paste the text. 





















		

4.




		



Click the cursor in the desired field.  Without moving the cursor out of the field, press  Shift+Insert (or Ctrl+V) on your keyboard.
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Shortcut Tips 




Account ID Hyperlinks 




Oracle Utilities Billing Component and Oracle Utilities Rate Management includes a convenient and time-saving shortcut for "jumping" from an open report to another module, while zeroing in on information about an account of interest. 






How to use the account shortcut: 










		

1.




		



Highlight the ID of an account of interest in an open report window. If the report was generated based on a customer/account list, you can also select the list name. 





















		

2.




		





Right -click in the report window, and select the desired option from the menu that appears.

















When the next dialog opens, the ID is already supplied. 
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Context-Sensitive Help 




Users can also get online help based on a specific function or screen. This is referred to as context-sensitive help. 




How to open context-sensitive help: 








		

1.




		



Open the function or screen you wish to find help about. 





















		

2.




		



Click the Help button in the Toolbar or press F1. 





















		

3.




		



An online help window opens displaying the corresponding topic. 
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File Menu 






Browse Customer/Account(s):  This lets you view information in the Oracle Utilities Data Repository about selected accounts; information is displayed via the browser. See the Data Manager User's Guide for details about the browser. See 

Browsing and Viewing Account Data

 for more information






View-›Account : This lets you view, update, add, and delete information about a selected account using the Account-Centric View. See 

Browsing and Viewing Account Data

 for more information.






Close : Closes an open report window.






Save : Saves an open revenue simulation or revenue adequacy file.






Save As... : Saves an open graph as a *.GIF or *.MET






Export : Exports the contents of an open report window to a file.






Print : Prints the contents of an open report or graph window. See 

Viewing and Printing Reports

 for more information.






Exit : Closes the Oracle Utilities Rate Management application.
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Oracle Utilities Rate Management Menus 




The Oracle Utilities Rate Management menus provide access to all Oracle Utilities Rate Management functions, as well as to all other Oracle Utilities products installed on your system. The following pages describe each option on each menu. 






Note:  Many of the options available via the menus are also available via the Toolbar. If the Toolbar does not appear on your screen, select Tools-›Display Toolbar.
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Edit Menu 






Cut : Not applicable to Oracle Utilities Rate Management








Copy : Copies a line of text that you have selected in a report, to the Clipboard where it is available for pasting into other applications such as Word.






Paste : Not applicable to Oracle Utilities Rate Management








Undo : Not applicable to Oracle Utilities Rate Management.






Redo : Not applicable to Oracle Utilities Rate Management.








Add : Add a new record to the database.






Update : Available only when the Browser is active.  Update a record in the database.






Delete : Available only when the Browser is active.  Delete a record from the database.






Note:  The Add, Update, and Delete options are operable only when the browser window is open.






Find  - This option allows you to search for a word or words in an open report window. When you select this option (or press F3), the Find dialog opens. See 

Viewing and Printing Reports

 for more information.






Find Next (Shift-F3)  - This option finds the next instance of the word or words last entered in the Find dialog.






Find Previous 

(Ctrl-F3) - This option find the previous instance of the word or words last entered in the Find Dialog.






Go To 

(Ctrl-G) - This option opens the Go To tab on the Find dialog and allows you to go to a specific line in an open report window. 






Browse Account:  Examine information in the Oracle Utilities Data Repository for a selected account using the Browser.






Note:  You must first highlight an Account ID in a report in order for this feature to be available.






View Account:  Examine information in the Oracle Utilities Data Repository for a selected account using the Account-Centric View.






Note:  You must first highlight an Account ID in a report in order for this feature to be available.






Refresh Cached Tables:  Refreshes the contents of tables displayed in the browser.






Font : Allows you to change the font in an open report window. See 

Viewing and Printing Reports

 for more information.
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Working with Oracle Utilities Rate Management 




This chapter describes how you work with the Oracle Utilities Rate Management application, including: 








		

•




		





Starting Oracle Utilities Rate Management 

























		

•




		





Oracle Utilities Rate Management Menus 

























		

•




		





Oracle Utilities Rate Management Toolbar 
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Default Options 
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Browsing and Viewing Account Data 
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Report Options 
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Viewing and Printing Reports 
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Using Online Help 
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Shortcut Tips 
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Saving and Applying Settings for Dialog Boxes 
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International and Multiple Currency Support 
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Oracle Utilities Rate Management Documentation Overview 
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This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.
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If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:
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Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.
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NOTIFICATION OF  THIRD-PARTY LICENSES



Oracle Utilities software contains third party, open source components as identified below. Third- party license terms and other third-party required notices are provided below.



License:  Apache 1.1



Module:  Crimson v1.1.1, Xalan J2



Copyright © 1999-2000 The Apache Software Foundation. All rights reserved.



Use of Crimson 1.1.1 and Xalan J2 within the product is governed by the following (Apache 1.1):



(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the disclaimer below in the documentation and/or other materials provided with the distribution. (3) The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/) ."  Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. (4) Neither the component name nor Apache Software Foundation may be used to endorse or promote products derived from the software without specific prior written permission. (5) Products derived from the software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission.



THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.



License:  CoolServlets.com



Module:  CS CodeViewer v1.0 (Sun JRE Component)



Copyright © 1999 by CoolServlets.com



Use of this module within the product is governed by the following:



(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the disclaimer below in the documentation and/or other materials provided with the distribution. (3) Neither the component name nor Coolservlets.com may be used to endorse or promote products derived from the software without specific prior written permission.



THIS SOFTWARE IS PROVIDED BY COOLSERVLETS.COM AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."



License:  Justin Frankel, justin@nullsoft.com



Module:  NSIS 1.0j (Sun JRE Component)



Use of this module within the product is governed by the following:



(1) The origin of the module must not be misrepresented, and Oracle may not claim that it wrote the original software. If Oracle uses this module in a product, an acknowledgment in the product documentation is appreciated but not required. (2) Altered source versions of the module must be plainly marked as such, and must not be misrepresented as being the original software. (3) The following notice may not be removed or altered from any source distribution: "Justin Frankel  justin@nullsoft.com".



License:  ICU4j License



Module:  ICU4j



Copyright © 1995-2001 International Business Machines Corporation and others. All rights reserved.



Oracle may use the software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the software, and to permit persons to whom the software is furnished to do so, provided that the above copyright notice and the permission notice appear in all copies of the software and that both the above copyright notice and the permission notice appear in supporting documentation.



THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.



License:  Info-ZIP



Module:  INFO-ZIP ZIP32.DLL (Binary Form)



Copyright (c) 1990-2005 Info-ZIP.  All rights reserved



Use of this dll within the product is governed by the following:



(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the definition and disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the definition and disclaimer below in the documentation and/or other materials provided with the distribution. The sole exception to this condition is redistribution of a standard UnZipSFX binary (including SFXWiz) as part of a self-extracting archive; that is permitted without inclusion of this license, as long as the normal SFX banner has not been removed from the binary or disabled. (3) Altered versions--including, but not limited to, ports to new operating systems, existing ports with new graphical interfaces, and dynamic, shared, or static library versions--must be plainly marked as such and must not be misrepresented as being the original source. Such altered versions also must not be misrepresented as being Info-ZIP releases--including, but not limited to, labeling of the altered versions with the names "Info-ZIP" (or any variation thereof, including, but not limited to, different capitalizations), "Pocket UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP. Such altered versions are further prohibited from misrepresentative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s). (4) Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "UnZipSFX," "WiZ," "Pocket UnZip," "Pocket Zip," and "MacZip" for its own source and binary releases.



[Definition]: For the purposes of this copyright and license, "Info-ZIP" is defined as the following set of individuals:



Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly, Hunter Goatley, Ed Gordon, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath, Jonathan Hudson, Paul Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden, Igor Mandrichenko, Steve P. Miller, Sergio Monesi, Keith Owens, George Petrov, Greg Roelofs, Kai Uwe Rommel, Steve Salisbury, Dave Smith, Steven M. Schweda, Christian Spieler, Cosmin Truta, Antoine Verheijen, Paul von Behren, Rich Wales, Mike White



[Disclaimer:] "This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the use of or inability to use this software."



License:  Paul Johnston



Modules:  md5.js



Copyright (C) Paul Johnston 1999 - 2002



Use of these modules within the product is governed by the following:



(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the disclaimer below in the documentation and/or other materials provided with the distribution. (3) Neither the component name nor the names of the copyright holders and contributors may be used to endorse or promote products derived from the software without specific prior written permission.



THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.



License:  Jef Poskanzer



Modules:  DES, 3xDES (Sun JRE Components)



Copyright © 2000 by Jef Poskanzer <jef@acme.com>. All rights reserved



Use of these modules within the product is governed by the following:



(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the disclaimer below in the documentation and/or other materials provided with the distribution. (3) Neither the component name nor the name of Jef Poskanzer may be used to endorse or promote products derived from the software without specific prior written permission.



THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.



License:  Sun Microsystems, Inc.



Modules:  Sun Swing Tutorials



Copyright© 1995-2006 Sun Microsystems, Inc. All Rights Reserved.



Use of these modules within the product is governed by the following:



(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the disclaimer below in the documentation and/or other materials provided with the distribution. (3) Neither the component name nor the name of Sun Microsystems, Inc. and contributors may be used to endorse or promote products derived from the software without specific prior written permission. (4) Oracle must acknowledge that the software is not designed, licensed or intended for use in the design, construction, operation or maintenance of any nuclear facility.



THIS SOFTWARE IS PROVIDED "AS IS," WITHOUT A WARRANTY OF ANY KIND. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. ("SUN") AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.



License:  Tom Wu



Module:  jsbn library



Copyright © 2003-2005 Tom Wu. All rights reserved



Use of this module within the product is governed by the following:



(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the disclaimer below in the documentation and/or other materials provided with the distribution.



THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL TOM WU BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
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From Another Application 




You can start Oracle Utilities Rate Management while working in another Oracle Utilities application program, such as Data Manager or Oracle Utilities Billing Component. From that program's desktop, select  Tools-›Oracle Utilities Rate Management.






Note:  If Oracle Utilities Rate Management is not available on the Tools menu, contact your System Administrator. (Oracle Utilities Rate Management must be added to the *.tls files.)
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Starting Oracle Utilities Rate Management  




From the Windows Desktop 




This section explains how to start Oracle Utilities Rate Management from the Windows desktop. (You can also start Oracle Utilities Rate Management from the command line and use switches to control which database is accessed and other features. Consult your System Administrator.) 




Depending upon how your system is configured, you can start Oracle Utilities Rate Management using one of two methods: 








		

•




		



Double-click the Oracle Utilities Rate Management icon, or 





















		

•




		



Click the  Start button in the lower-left corner of the Windows desktop. Then, select Programs-›Oracle Utilities-›Oracle Utilities Rate Management.

















Depending upon your system configuration (or if an error occurs during database initialization), the logon screen appears. 








		

•




		



User Name: the user ID for the database connection* 





















		

•




		



Password: the password for the supplied user ID* 





















		

•




		



Data Source Name: The data source name and provider for the database, in one of the following formats: 

















For Oracle databases: 




"Data Source=<data_source>;LSProvider=ODP;" 




* User Name and Password are optional—if you do not supply them, the UserID defaults to your Windows logon ID. 




When you complete the fields and click  OK, the Oracle Utilities Rate Management desktop appears. You are now ready to begin.
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Generating Typical Bill Scenarios 




This chapter explains how to use Typical Bill analysis. Typical Bill lets you simulate billing determinants and compute revenue from a rate schedule, and compare the difference in revenue between two rate schedules. 








		

•




		





The Purpose of Typical Bill Analysis 

























		

•




		





Running a Typical Bill Analysis 
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Running a Customer Impact Analysis 




How to Run a Customer Impact Analysis: 








		

1.




		



Select  Analysis-›Customer Impact.

















The  Customer Impact dialog box appears.








		

2.




		



Select either  Account or Customer in the Select By box.





















		

3.




		





Select  the accounts or customers of interest using one of the following options:





















		

•




		





All:  Select this option if you want to apply the analysis to all accounts or customers in the database.





















		

•




		





ID:   Type the ID of one account or customer.





















		

•




		





List:   Select the list that contains the IDs of the customers or accounts that you want to include in the analysis.  If you believe that the contents of the list may have changed since the last time that the query associated with it was run, check the box for Refresh list before using.  This option updates the list for this job and saves the new version of the list to the database, replacing the old version.





















		

4.




		



Specify the  Test Period From/To: by entering the start- and end-month using the MM/YYYY format.





















		

5.




		



To select a rate schedule as the basis of comparison, click the  Add button.

















The  Select Rate Schedule and

Optional Rate Code dialog box appears. This dialog gives you access to all rate schedules and rate codes currently stored in the Oracle Utilities Data Repository.








		

6.




		



Select an  Operating Company, Jurisdiction, and Rate Schedule.





















		

7.




		



Check one or more rate schedule  Types (Current/Historical or Trial).  Your selections here determine which schedules are listed in the Type selection box (e.g., if you click just the Trial box, only those schedules stored as "Trial" are available for selection in the selection box).





















		

8.




		



Highlight one rate schedule in the selection box. 

















To help you make your selection, Oracle Utilities Rate Management displays the first 50 lines of the selected rate schedule text in the lower window. If you wish to view the entire schedule (beyond 50 lines), click  Show All. The text in this window is view-only—you cannot edit the schedule here.








		

9.




		



If the base rate schedule includes SELECT RATE CODE statements that apply different calculations to customers on different rate codes, and the customers in the analysis have rate codes other than those in this base rate schedule, you must select a single rate code to be used as the base rate code. To do so, select the rate code from the  From Rate Schedule Rate Code drop-down list. If you leave this selection blank, Customer Impact checks the Account Rate Code History Table for the rate schedule/rate code of the account. If it matches the analysis rate schedule/rate code, Customer Impact applies it. Otherwise, Customer Impact skips the rate code-specific statements.



















Note:  Inter-schedule mapping is disabled for the base rate schedule, since you are specifying the rate code to be mapped to.










		

10.




		



Click  OK to be returned the Customer Impact dialog box.





















		

11.




		



Specify as many comparison rate schedules as you'd like, by repeating steps 4 through 9, keeping in mind one important difference in step 8 (when you specify the rate code).  If the comparison rate schedule includes SELECT RATE CODE statements that apply different calculations to customers on different rate codes, and the customers in the analysis have rate codes other than those in this comparison rate schedule, you must specify which rate code Customer Impact applies.  There are three possible scenarios: 





















		

•




		



You can explicitly select a rate code from comparison rate schedule using the  From Rate Schedule Rate Code drop-down list, or





















		

•




		





Available only if you are applying the comparison to a list of customers or accounts.  You can check the Inter-schedule Mapping option. In that case, Oracle Utilities Rate Management applies the rate code from the comparison rate schedule that most closely matches the customer's current rate code (as defined in the Inter-Schedule Mapping Table—see 

Appendix A

: 

Mapping Rate Codes Between Rate Schedules

 for instructions on setting up and maintaining this table).





















		






		





Note:  If you check the Inter-schedule Mapping option, the listbox above it must be blank. If the box has a selection, simply click the small down arrow to the right of the list box and highlight the blank line in the list. If you do select Inter-schedule Mapping, the analysis will be slower.





















		






		



If you do not select a rate code using either of the two options just described, Customer Impact uses the rate code from step 8 above, if the base and comparison rate schedules are the same. 





















		






		



If if the schedules are  not the same, Customer Impact checks the Inter-Schedule Mapping Table for applicable mappings. If none have been defined, Oracle Utilities Rate Management considers the rate code empty and skips over the rate code-specific statements.





















		

12.




		





Optional.  To include a Minimum Bill Report, check the Append Minimum Bill Report checkbox. See 

Chapter 10



: 



The Minimum Bill Report

 for more information.



















Note:  In order to include the Minimum Bill Report, you must include the MINIMUM_BILL_REPORT=1 parameter in the LODESTAR.CFG file. See Chapter 2: Configuration Files in the Oracle Utilities Energy Information Platform Configuration Guide for more information.








		

13.




		



Select the number of decimal places to display for Bill Determinants from the  Bill Determinants Displayed to n Decimal Places drop-down list. If the number in the database has more decimal places than the number selected, the number displayed on the report is rounded off the number of decimals selected. If the number in the database has less decimal places than the number selected, the number displayed on the report will have zeros appended to the end to display the number of decimals selected. The default setting is 1.





















		

14.




		



If you want to flag customers that would be better off on another rate schedule, click the  Advanced button.

















The  Advanced Customer Impact Inputs dialog box appears.








		

15.




		



Complete this dialog as follows: 



















Analysis Name: 

Optional.  Type a name to appear in the report window's title bar.






$ Difference:  Click the check box and supply a dollar value. If you use this option, the program will flag customers with a dollar difference between revenue from the base rate schedule and revenue from any of the other rate schedules greater than the amount you supplied (for the entire test period). This value is divided by the number of months in the test period and the result is used as the absolute comparison value for each month; the input value is used as the comparison value for the total of all months.






% Difference:  Click the checkbox and supply a percent value. If you use this option, Customer Impact flags customers with a percent difference between revenue from the base rate schedule and revenue from any of the other rate schedules greater than the amount you supplied (total difference is compared, not monthly difference).






Report:   If you selected any switch threshold options, you can choose either All Customers if you don't want to limit the output, or All Over Threshold if you want to report just those customers that may switch to another rate schedule.






Enter Name for List of Customers:  If you want the program to create a list of the customers who may switch to another rate schedule, enter a name for the list here.






Assign each customer to its best rate's list:  Check here if you want the program to create a list for each rate (the list name is the supplied list prefix appended with the rate schedule name). A customer will be added to a rate list if the customer's bill is the minimum on that rate (ties go to the first rate with the minimum).






Append Billing Impact Frequency Report based on blocking:  If you check this option, a Billing Impact Frequency Report page will be appended to the Customer Impact Report. You must select a blocking to use in creating this report. The blocking can contain at most 201 steps (-100 to 100 by 1,-500 to 500 by 5, etc.).






Report Options:  Click this button to define report options such as adding report titles and saving the results to a file. Note: If you want to graph the results or save the report to a CSV file, check the Keep Data option on the 

General Options

 tab of the 

Report Options

 dialog.








		

16.




		



Click  OK to return to the Customer Impact dialog box.





















		

17.




		



You have two options for outputting the results of the analysis: 



















Graph:   Creates a graph and report of the results.






Report:   Creates a tabular report.








		

18.




		



Once you have created the report, you can export or print it through the  File menu.
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Required Inputs 




Before you can perform a customer impact analysis, you must have already created and saved the following inputs in the Oracle Utilities Data Repository using Data Manager: 








		

•




		



rate schedules, rate codes, and (optionally) inter-schedule mappings 





















		

•




		



the list of customers or accounts you wish to analyze (if you want to work with just a single customer or account, the list is not necessary) 





















		

•




		



the customers' billing determinant data for the test period. 

















Refer to the  Data Manager User's Guide and the Rules Language User's Guide for instructions on creating these inputs.








OEBPS/Text/part0075.xhtml






The Purpose of Customer Impact Analysis 




Oracle Utilities Rate Management Customer Impact lets you analyze the effect of a change in a rate schedule on a group of customers. The report shows the bill determinant values for each month and in total. Depending on how you structure the rate schedule, the report also shows billing determinant values computed using formulas specified in the rate schedule. 




You can compare any number of rate schedules at one time.  The report shows the revenue for each month, the difference between the first (base) schedule and the other schedules, and whether or not a customer is likely to switch to a new rate. 




Customers that would be better off on another rate schedule can be flagged and put into a list for further analysis.  This helps you identify customers migrating from one rate to another. 




Customer Impact produces Individual and Summary reports, which you can save and print. 




Any information on the report can be graphed and analyzed further. You can save and print graphs. 




Customer Impact can also be run in batch mode using a command line program. For more information, see  

Customer Impact

 of 

Appendix B

: 

Setting Up Oracle Utilities Rate Management to run in Batch Mode

.
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Customer Impact Analysis (Rate Comparisons) 




This chapter explains how to use Oracle Utilities Rate Management to compare the effect of different rate schedules on one or a group of customers and to identify migrating customers. 








		

•




		





The Purpose of Customer Impact Analysis 

























		

•




		





Running a Customer Impact Analysis 
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The Revenue Simulation Window 




The following window shows unadjusted amounts in a Revenue File that Oracle Utilities Rate Management displays in the Revenue Simulation window. Depending on how you define a rate schedule, a Revenue File will have a varying amount of detail. 




The following window shows adjusted amounts in the same Revenue File. You can adjust different amounts and see the effect on related column amounts. 




How to save your changes: 




To save the revenue simulation results with the same name as the version you originally opened, select  File-›Save. To save the file with a new name, selectFile-›Save As.




How to export the file: 




You can also export the revenue analysis in either of two ASCII formats. The first is a ".CSV" or "comma separated values" format, which is compatible with most spreadsheet programs. The second format is a ".REV" format, which is designed to enable you to share the file with other Oracle Utilities Rate Management users and workstations. 








		

1.




		



Select  File-›Export.





















		

2.




		



Select the file type, either .CSV or .REV. 





















		

3.




		



Save the report in whatever directory you like. 
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Running a Revenue Simulation 




How to Open a Revenue Analysis File: 




You can open the results of either a Bill Frequency or Customer Revenue Analysis. 








		

1.




		



Select  Analysis-›Revenue Simulation.

















The  Revenue Simulation dialog box appears.








		

2.




		



Complete the dialog: 





















		

•




		





Name:  Select the revenue analysis results that you would like to manipulate.





















		

•




		





Comment:   Optional note.





















		

•




		



Click  Open.



















Note:  Alternately, you can import a Revenue Simulation File (extension .REV) from a diskette or another area of your network by selecting Import.




How to adjust the amounts: 




You can modify the figures in the adjusted columns and immediately see the impact. (See the table below for detailed information about the columns you can edit. See also the illustration at right.) 








		

1.




		



Click the mouse pointer in a cell whose value you want to change. 





















		

2.




		



Type the new figure as desired, and press Enter. 

















Oracle Utilities Rate Management performs the calculations and updates the figures. 








		



Column 




		



 Description 










		





Target Revenue 






		



The Target Revenue value may be changed to represent the amount of revenue required for the next billing period. Changing this value has no effect on the other adjusted values, it is simply a place holder. 











Changing the Target Revenue will also alter the Revenue Difference (Rev Diff). 










		





Adjusted Units 






		



The Adjusted Units value may be altered to compute a new Adjusted Revenue value. Adjusted Units are multiplied by the Adjusted Rate to determine the Adjusted Revenue. If there is an Adjusted Distribution associated with the Adjusted Units, then it is also adjusted. 










		





Adjusted Rate 






		



The Adjusted Rate may be changed to modify the Adjusted Revenue. The Adjusted Rate is multiplied by the Adjusted Units to calculate the new Adjusted Revenue. 










		





Adjusted Revenue 






		



Changing the Adjusted Revenue will alter the Adjusted Rate. The new Adjusted Rate is calculated by dividing the Adjusted Revenue by the Adjusted Units. 











Changing the Adjusted Revenue will also alter the Revenue Difference (Rev Diff). 
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Required Inputs 




Before you can perform revenue simulation, you must have already created and saved the grand summary results of the revenue analysis with which you wish to work. Perform either a Customer or Bill Frequency Revenue Analysis and save the results to the database. This is accomplished by selecting  Revenue-›Save while the Revenue Analysis Report window is active. You may be prompted for a name and optional comment.
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Purpose of Revenue Simulation 




A summary of bills is created when a customer or bill frequency revenue calculation is performed and the results are saved to the database. Normally, the customer list used for such calculations consists of all customers on a particular rate schedule and possibly a particular rate code. The information saved to the database coincides with the grand total page in the report produced by the revenue analysis. 




Revenue Simulation allows you to adjust the grand summary results of a revenue analysis. Initially, Oracle Utilities Rate Management displays the analysis results in a table format, with two identical sets of data shown side-by-side. The left side contains the original values; the right side, the "adjusted" values. The adjusted columns are there for you to modify as desired. Typically, you first adjust the determinant units to fit a predicted usage, and then adjust the prices to generate the required revenue. Once the best prices have been determined, you can update the prices in the original rate schedule to create a new rate schedule for the next year. 
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Adjusting Revenue and Price Using Revenue Simulation 




This chapter explains how to use the Revenue Simulation feature of Oracle Utilities Rate Management. The purpose of Revenue Simulation is to take the results of a revenue analysis and manipulate various components to achieve a desired revenue or to determine an optimum price. 








		

•




		





Purpose of Revenue Simulation 

























		

•




		





Running a Revenue Simulation 
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Running a Single Step Analysis 




How to Run a Single Step Analysis: 








		

1.




		



At the Oracle Utilities Rate Management desktop, select  Analysis-›Single Step.

















The  Single Step Customer Revenue dialog box appears.








		

2.




		



In the  ID field, type the ID of the account whose bill determinant data you want to analyze.





















		

3.




		



Specify the  Bill Month using the MM/YYYY format. 





















		

4.




		



Select a rate form for the analysis using one of the following options: 





















		

•




		





Select Rate Form:  Click this radio button, then the Select Rate Form button if you want to select a specific rate schedule from the database. The Select Rate Schedule

and

Optional Rate Code dialog box appears. This box gives you access to all current, historical, and trial rate schedules stored in the Oracle Utilities Data Repository. Go to step 5.





















		

•




		





Customer's Billing Rate Form:  Click this radio button if you want Oracle Utilities Rate Management to use the current rate schedule version belonging to the account. Go to step 10.





















		

5.




		



In the  Select Rate Schedule

and

Optional Rate Code dialog box, select an Operating Company, Jurisdiction, and Rate Schedule.





















		

6.




		



Check one or more rate schedule  Types (Current/Historical or Trial).  Your selections here determine which schedules are listed in the Type selection box (e.g., if you click just the Trial box, only those schedules stored as "Trial" are available for selection in the selection box).





















		

7.




		



Highlight one rate schedule in the selection box.

















To help you make your selection, Oracle Utilities Rate Management displays the first 50 lines of the selected rate schedule text in the lower window. If you wish to view the entire schedule (beyond 50 lines), click  Show All. The text in this window is view-only—you cannot edit the schedule here.








		

8.




		



If the selected rate schedule has clauses for customers on different rate codes, you must specify the rate code that Oracle Utilities Rate Management will apply for the analysis. There are two options: 





















		

•




		



Select a rate code from the  From Rate Schedule Rate Code list, or 





















		

•




		



Leave the rate code blank, in which case Oracle Utilities Rate Management will use the rate code associated with the account. If there is no rate code associated with the account, Oracle Utilities Rate Management will skip the rate code-specific calculations. 





















		

9.




		



Click  OK when the Select Rate Schedule and Optional Rate Code dialog is completed to be returned to the Single Step Customer Revenue dialog box.



















Note:  The name of the selected rate schedule and (optionally) rate code are displayed.








		

10.




		





Optional.  To apply additional report features, such as custom titles and whether or not to write the report to a file, click the Report Options button. See the on-line help for details.





















		

11.




		



In the  Single Step Customer Revenue dialog box, click OK to begin the single step analysis.

















The windows for the Single Step module appear. 




The module consists of two to three windows (depending upon whether or not the rate schedule incorporates interval data). The top left window displays the statements that make up the rate form.  The next statement to be executed is highlighted there (comments are skipped).  The top right window displays the identifiers in the rate form and their values.  The lower window is a graphical display of the interval data (displays only when an interval data identifier is highlighted in the top right window). 




When the rate form is first displayed, the first executable statement is highlighted.  To execute the statement, select  Single-Step-›Step from the menu bar, or press F8. You can execute each statement this way. If you want the program to step through the schedule automatically, much like a slide show, select  Single-Step-›Jog.




To execute the rate form  only up to a particular statement, highlight the statement in the upper left window and select Single-Step-›Run to Selection from the menu bar, or press F4 (that way, you avoid having to single-step through every statement prior to the one of interest).




To run all statements to completion, select  Single-Step-›Run or press F5.  To return to the first statement, select Single-Step-›ReStart or press F10. If you want to view all identifiers in the rate schedule at once—including temporary identifiers that are otherwise displayed only when the particular statement executes—select Show all identifiers.




The upper right window displays the identifiers in the rate form. The first word in each line tells you the type of identifier. Next on the line is the identifier name. If the identifier has a value, computed or not, the value is also displayed, along with its type. 








		

12.




		



If desired, you can double-click on an identifier to modify it. A dialog box appears with the value in an edit box. You can change the value, and click  OK to save the value in the executing rate schedule. If the identifier is an interval data handle, the value displayed contains its total, maximum, pulse multiplier, and pulse offset. This value is not modifiable.





















Note:  You must enter the same value type—Integer, Float, etc.—as the current value.








		

13.




		



After you have run the statements, you can view the resulting report by selecting  Single-Step-›Display Report from the menu bar, or press F6. 

















You can export or print the report using options from the File menu.  You can also search for selected text or copy all or a selected portion to the clipboard using options from the Edit menu. 








		

14.




		



To close the report, select  File-›Close.
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Required Inputs 




Before you can perform a single step analysis, you must have already created and saved the following inputs in the Oracle Utilities Data Repository using Data Manager: 








		

•




		



the rate form 





















		

•




		



the customers' billing determinant data for the bill month. 

















Please refer to the  Data Manager User's Guide for instructions on creating these inputs.
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Purpose of Single Step Analysis 




Single Step Analysis computes the revenue amount for one customer for one month.  You view and control the computations on-screen, executing one rate schedule statement at a time.  You can modify identifier values and see the impact immediately. 








OEBPS/Text/part0065.xhtml






Single Step Analysis 




This chapter explains how to compute revenue for one customer for one month using Single Step Analysis. This feature is especially useful for exploring the impact of various aspects of a rate form, since you control the pace and content of the calculations in "real time"—stepping through the rate form on-screen, one line at a time, modifying identifier values if desired. 








		

•




		





Purpose of Single Step Analysis 

























		

•




		





Running a Single Step Analysis 
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Running a Customer Revenue Analysis 




How to Run a Customer Revenue Analysis: 








		

1.




		



Select  Analysis-›Customer Revenue.

















The  Compute Revenue for Account(s) dialog box appears.








		

2.




		



Under  Select By, choose either Account or Customer. Then, Select the accounts or customers of interest using either of the following options:





















		

•




		





ID:  Type the ID of the account or customer.





















		

•




		





List:  Select the list that contains the IDs of the customers or accounts that you want to include in the analysis. If you believe that the contents of the list may have changed since the last time that the query associated with it was run, check the box for Refresh list before using. This option updates the list for this job and saves the new version of the list to the database, replacing the old version.





















		

3.




		



Specify the  Test Period

From/To: by entering the start- and end-month using the MM/YYYY format. You can specify from one to 24 months.





















		

4.




		



Select a rate schedule using one of the following options: 





















		

•




		





Select Rate Schedule:  Click this radio button, then the Select Schedule button if you want to select a rate schedule from the database. The Select Rate Schedule

and

Optional Rate Code dialog box appears. This box gives you access to all current, historical, and trial rate schedules stored in the Oracle Utilities Data Repository. Go to step 5.





















		

•




		





From first Account in list:  Click this radio button if you want Oracle Utilities Rate Management to use the current rate schedule version belonging to the first account in the list. Go to step 10.





















		

5.




		



In the  Select Rate Schedule

and

Optional Rate Code dialog box, select an Operating Company, Jurisdiction, and Rate Schedule.





















		

6.




		



Check one or more rate schedule  types (Current/Historical or Trial).  Your selections here determine which schedules are listed in the Type selection box (e.g., if you click just the Trial box, only those schedules stored as "Trial" are available for selection in the Type selection box).





















		

7.




		



Highlight one rate schedule in the  Type Selection box.

















To help you make your selection, Oracle Utilities Rate Management displays the first 50 lines of the selected rate schedule text in the lower window. If you wish to view the entire schedule (beyond 50 lines), click  Show All. The text in this window is view-only—you cannot edit the schedule here.








		

8.




		



If the selected rate schedule has clauses for customers on different rate codes, you must specify one rate code that Oracle Utilities Rate Management will use for the entire list. There are three options: 





















		

•




		



Select a rate code from the  From Rate Schedule Rate Code list, or 





















		

•




		



Check  Inter-schedule mapping. In that case, Oracle Utilities Rate Management applies the rate code from the analysis rate schedule that most closely matches the customer's current rate code. (as defined in the Interschedule Mapping Table—see 

Appendix A





Mapping Rate Codes Between Rate Schedules

 for instructions on setting up and maintaining this table).





















		






		





Note:  If you select Inter-schedule Mapping, the listbox above it must be left blank. If the box has a selection, simply click the small down arrow to the right of the list box and highlight the blank line in the list.





















		






		



If you do not select a rate code using either of the two options just described, Oracle Utilities Rate Management will use the customer's current rate schedule/rate code if it is the same as the analysis rate schedule/rate code. Otherwise, any rate code-specific calculations are skipped. 





















		

9.




		



Click  OK when the Select Rate Schedule

and

Optional Rate Code dialog is completed.

















The  Compute Revenue for Bill Frequency Table dialog box reappears.  The name of the selected rate schedule and (optional) rate code are displayed.








		

10.




		



If you selected a current or historical rate schedule, you can also select the  Use historical schedule version checkbox. This option uses the rate schedule version that was in effect for each revenue month. If you do not select this option, Oracle Utilities Rate Management applies just the version you specified in the Select Rate Schedule and Optional Rate Code dialog to the entire test period.





















		

11.




		





Optional.  To include a Minimum Bill Report, check the Append Minimum Bill Report checkbox. See 

Chapter 10



: 



The Minimum Bill Report

 for more information.



















Note:  In order to include the Minimum Bill Report, you must include the MINIMUM_BILL_REPORT=1 parameter in the LODESTAR.CFG file. See Chapter 2: Configuration Files in the Oracle Utilities Energy Information Platform Configuration Guide for more information.








		

12.




		





Optional.  For additional analysis and reporting options, click Advanced.

















The  Advanced Compute Revenue for Customer(s) dialog box appears.








		

13.




		



Complete the dialog box as follows: 



















Analysis Name:  

Optional. Type an analysis name to appear in the title bar of the report window.






Report Options:  Click this button to define report options such as custom titles and whether or not to write the report to a file. See the on-line help for details.






Include :








		

•




		





All Bill History Months:   This is the default option—the analysis will use all billing history months with the date range unconditionally.





















		

•




		





Months with Same Schedule:   Choose this option to limit the billing months that are reported and analyzed. This option will drop any billing months that have a different rate schedule code than the rate schedule selected.





















		

14.




		



Click  OK to return to the Compute Revenue for Customer(s) dialog box.





















		

15.




		



Click  OK to generate the report.





















		

16.




		



To save the grand summary results for further analysis (such as Revenue Adequacy or Revenue Simulation), select  Revenue-›Save. (See later chapters for a description of these analyses.)
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Required Inputs 




Before you can perform a customer revenue analysis, you must have already created and saved the following inputs in the Oracle Utilities Data Repository using Data Manager: 








		

•




		



the rate form(s), including any riders, 





















		

•




		



the list of customer or accounts you wish to analyze (if you want to work with just a single customer or account, the list is not necessary), and 





















		

•




		



the customers' billing determinant data for the test period. 

















Please refer to the  Data Manager User's Guide for instructions on creating these inputs.






Note:  Oracle Utilities Rate Management lets you specify the desired rate form for the analysis. Or, you can let Oracle Utilities Rate Management use the current rate form version belonging to the first customer in the list.
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Purpose of Customer Revenue Analysis 




Customer Revenue Analysis enables you to apply the formulas in a rate form to one or a group of user-selected customers over a test period (from one month to two years), and to report the resulting revenue. Depending upon how you structured the rate form, the report will show the revenue generated by each component of the rate formula and the number of billing units, as well as the total dollar amount. You can save and print the reports.  




Customer Revenue can also be run in batch mode using a command line program. For more information, see  

Customer Revenue

 of 

Appendix B

: 

Setting Up Oracle Utilities Rate Management to run in Batch Mode

.
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Customer Revenue Analysis 




This chapter explains how to compute trial revenue by applying a rate schedule to billing determinant data for one customer or a group of customers over a user-specified test period. 








		

•




		





Purpose of Customer Revenue Analysis 

























		

•




		





Running a Customer Revenue Analysis 
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Creating a Bill Frequency Revenue Analysis 




Bill Frequency Revenue Analysis lets you apply a selected rate schedule to the bill determinant data in a Bill Frequency Table over a user-specified number of bill months.  This analysis is especially useful for computing revenues for very large customer populations when you do not have the time or computer resources to process individual bills multiple times. 




When specifying the analysis rate schedule, you can choose from the current or historical versions. 






Note:  You cannot apply this analysis to rate schedules that have block expanders or hours use rate.




How to create a Bill Frequency Revenue Analysis: 








		

1.




		



At the Oracle Utilities Rate Management desktop, select  Analysis-›Bill Frequency-›Revenue.

















The  Compute Revenue for Bill Frequency Table dialog box appears.








		

2.




		



In the  Bill Frequency Table field, select the desired .bft file.





















		

3.




		



Specify the  Test Period by entering the start- and end-month using theMM/YYYY format. Oracle Utilities Rate Management automatically displays the dates of the selected Bill Frequency Table; accept the dates, or specify a shorter range within those dates.





















		

4.




		



Select the rate schedule that you wish to apply by clicking  Select Schedule.

















The  Select Rate Schedule

and

Optional Rate Code dialog box appears.








		

5.




		



Select an  Operating Company, Jurisdiction, and Rate Schedule.





















		

6.




		



Check one or more rate schedule  types (Current/Historical or Trial).  Your selections here determine which schedules are listed in the Type selection box (e.g., if you click just the Trial box, only those schedules stored as "Trial" are available for selection in the Type selection box).





















		

7.




		



Highlight one rate schedule in the Type Selection box. 

















To help you make your selection, Oracle Utilities Rate Management displays the first 50 lines of the selected rate schedule text in the lower window. If you wish to view the entire schedule (beyond 50 lines), click  Show All.The text in this window is view-only—you cannot edit the schedule here.




If the selected rate schedule has clauses for customers on different rate codes and you did not specify rate code groups in the Bill Frequency Table, it is recommended that you explicitly specify one rate code that Oracle Utilities Rate Management will use for the entire population. To do so, select a rate code from the From Rate Schedule Rate Code pull-down list. Alternatively, if the Bill Frequency Table has Rate Code Groups, you can select the blank from the same.








		

8.




		



Click  OK to return to the Compute Revenue for Bill Frequency Table.





















		

9.




		



Click  OK to run the Revenue Report.
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About the Bill Frequency Analysis Report Format 




Here is a sample portion of the Bill Frequency Analysis Report, and an explanation of each of the columns in the report. 








		





(1) 






		





(2) 






		





(3) 






		





(4) 






		





(5) 






		





(6) 






		





(7) 






		





(8) 






		





(9) 






		





(10) 












		





Upper End 






		





#Bills 






		





#Bills Acc 






		





#Bills Rev 






		





Block Determ 






		





Det Accum 






		





Det Accum Rev 






		





Det Billed 






		





Accum Price 






		





Acc Price Rev 












		





0 






		





20 






		





20 






		





196 






		





0 






		





0 






		





10,191,275 






		





0 






		





0 






		





10,191,275 












		





10,000 






		





1 






		





21 






		





195 






		





9,600 






		





9,600 






		





10,181,675 






		





1,959,600 






		





1,959,600 






		





8,231,675 












		





20,000 






		





8 






		





29 






		





187 






		





133,620 






		





143,220 






		





10,048,055 






		





1,923,620 






		





3,883,220 






		





6,308,055 












		





30,000 






		





31 






		





60 






		





156 






		





773,500 






		





916,720 






		





9,274,555 






		





1,713,500 






		





5,596,720 






		





4,594,555 












		





40,000 






		





31 






		





91 






		





125 






		





1,094,025 






		





2,010,745 






		





8,180,530 






		





1,414,025 






		





7,010,745 






		





3,180,530 












		





50,000 






		





31 






		





122 






		





94 






		





1,399,140 






		





3,409,885 






		





6,781,390 






		





1,099,140 






		





8,109,885 






		





2,081,390 












		





60,000 






		





35 






		





157 






		





59 






		





1,910,895 






		





5,320,780 






		





4,870,495 






		





750,895 






		





8,860,780 






		





1,330,495 












		





70,000 






		





20 






		





177 






		





39 






		





1,265,665 






		





6,586,445 






		





3,604,830 






		





455,655 






		





9,316,445 






		





874,830 












		





80,000 






		





10 






		





187 






		





29 






		





759,910 






		





7,346,355 






		





2,844,920 






		





349,910 






		





9,666,355 






		





524,920 












		





90,000 






		





12 






		





199 






		





17 






		





1,011,260 






		





8,357,615 






		





1,833,660 






		





221,260 






		





9,887,615 






		





303,660 












		





100,000 






		





6 






		





205 






		





11 






		





570,360 






		





8,927,975 






		





1,263,300 






		





140,360 






		





10,027,975 






		





163,300 












		





Addt'l 






		





11 






		





216 






		





0 






		





1,263,300 






		





10,191,275 






		





0 






		





163,300 






		





10,191,275 






		





0 




















		

1.




		





Upper block ending:   First block ending = 0.





















		

2.




		





Number of bills in block:   Count of bills in this reference block.  (For bimonthly customers, count bill twice—determine block after dividing usage by 2.)





















		

3.




		





Number of bills accumulated:   Accumulated sum of the bills in this and all previous blocks.





















		

4.




		





Number of bills reverse accumulation:   Number of bills remaining above this reference block.  This value is equal to the total number of bills (sum of column 2) minus the reference block's value in column 3.





















		

5.




		





Determinant in block:   Sum of determinants in this reference block.





















		

6.




		





Determinant accumulated:  Accumulated sum of all determinants less than this reference block's upper end.  This value is equal to the reference block's value in column 5 plus the previous block's value in column 6.





















		

7.




		





Determinant amounts from bills above block limit:  Accumulated sum of all determinants remaining above this block's upper end. This value is equal to the total of all determinants (sum of column 6) minus reference block's value in column 5.





















		

8.




		





Determinant billed in block:  Sum of each determinant portion between the previous block's upper end and this reference block's upper end). This value is equal to the following formula:

















(Upper block ending * Number of bills reverse accumulation) + Determinant in block - (Previous block's number of bills reverse accumulation * Previous block's upper end). 




For example, if this formula were applied to the third block in the sample report at right: 




(20,000 * 187) + 133,620 - (195 x 10,000) =1,923,620  








		

9.




		





Accumulated price blocks for determinant:   Amount of determinant in this and all previous blocks.  This value is equal to the reference block's value in column 8 plus the previous block's value in column 9.





















		

10.




		





Reverse accumulated price blocks for determinant:   Amount of determinant remaining above this reference block.  This value is equal to the total of all determinant price blocks (sum of column 8) minus the reference block's value in column 9.
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Rate Analysis Options 




The Rate Analysis tab specifies default values for processing rate schedules and running reports. 






Default Rate Schedule:   Choose a default rate schedule for calculating charges. This is the default schedule selected when running trial calculations.






Test Period:   Can be any period, one month or greater. This period is used as the default time range for the Billing History Report, Special Events Report, and Trial Calculations.






Default Season Schedule:   Select a season schedule for the calculations.






Note:   If when running an analysis or calculation, the input rate form includes a statement that assigns a value to the SEASON_SCHEDULE_NAME identifier, the value in the rate form takes precedence over the Options selection.






Display Line Numbers:  If this checkbox is checked, the Rules Language Editor and Rules Language Text Editor display line numbers at the beginning of each statement/line. Line numbers also appear in the Trial Calculuation window.






Maximum number of Undo's allowed:  This field sets the maximum number of Undos allowed in the Rules Language Editor. The default is 1.






Display ‘Saved by' comments at end : If selected, the ‘Saved by' comments inserted in rate schedules are inserted at the bottom of rate schedules instead of at the top. This option unselected by default.
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General Options 




The General tab specifies a number of default values and formatting preferences used by the system. 






Default Operating Company:   Choose the default operating company for bill calculations and rate analyses.






Default Jurisdiction:   Choose the default jurisdiction for bill calculations and rate analyses.






Account ID:   Choose the default ID for bill calculations and rate analyses.






Minimum printed line width:   The type size in printed reports is partially determined by the number of characters that you specify here. The recommended setting is 110 characters, which yields approximately 10 to 12 point type (depending upon your printer).  If you do not supply a value here the programs automatically sizes the type based on the longest line in the report.  So for example, if the longest line were 40 characters, the program would size the type so that the 40 characters filled the entire width of the page, which most likely would yield uncomfortably large type. On the other hand, if the longest line in the report is longer than the value you specify here, the value has no effect.






Default to landscape printing after this # of characters:  If a line single line in a report contains this many characters, the report will default to landscape printing. This allows the user to print reports in landscape mode without having to manually change the mode in the printer's properties dialog box.






Display calculation time with date on each report page:   The date/time is displayed on every page of every report. If this option is checked,  the time is also displayed with the date. 






Date Format:  Your selection here dictates the format used to enter dates via the graphical user interface, and how they are displayed in reports. (This setting is not dependant upon, nor does it affect, how dates are stored by your database software.)




Your three options are: 








		

•




		





MM/dd/yyyy hh:mm:ss: 

  Month-day-year, hours-minutes-seconds.























		

•




		





yyyy-MM-dd hh:mm:ss: 

  Year-month-day, hours-minutes-seconds.























		

•




		





Windows Regional Settings: 

  Default Options will draw from the Date tab of the Regional Settings Windows Control Panel.























		






		



Using the Windows Regional Settings, you will have greater flexibility in the formats available to you.  You can set a 2-digit year (although the 4-digit, Y2K-compliant date will still be used internally), a European format (day-month-year), and so on. 





















		






		





Note:  If you change the Windows Regional Settings while an application (Data Manager, Oracle Utilities Billing Component, etc.) is running, you must restart the application in order for the new settings to take effect.
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Default Options 




The Options feature allows you to set your own default values for several frequently used parameters. You can set your preferred defaults via Data Manager or another Oracle Utilities product (such as Oracle Utilities Billing Component) and store them in the Oracle Utilities Data Repository. In that way, whenever you open a Oracle Utilities program, these values are automatically supplied—saving you the time and effort of defining them each and every time. 




When you are working in any of the Oracle Utilities application programs, you can also override your defaults for individual work sessions, or even specific dialog boxes throughout the programs.  Whenever you see the  Options button on a dialog box, you can click it to open the Options box to override the defaults.




Available options include: 








		

•




		





General Options 

























		

•




		





Rate Analysis Options 

























		

•




		





Billing Options 

























		

•




		





Interval Data Source 

























		

•




		





Interval Data Options 

























		

•




		





Interval Data Merge 

























		

•




		





Error Handling 

























		

•




		





User Files 





















How to set default options: 








		

1.




		



At the Desktop, select  Tools-›Options.  

Or, Click the Options button on the current active dialog box.





















		

2.




		



Set your options on each tab as desired. 





















		

3.




		



 When you have completed the tabs as desired, click  OK to save the new settings as your defaults, replacing the previous settings. Any Oracle Utilities program you run will automatically use these defaults. If you click Apply, the result depends on how you opened the Default Options dialog:





















		

•




		



If you opened the  Default Options dialog from the main menu, your new settings apply to all of your work for remainder of your current session. The settings will revert to the original defaults when you quit the Oracle Utilities programs.





















		

•




		



If you opened the  Default Options dialog by selecting the Options button in a dialog box, your new settings apply to just the current job.

















The next several pages contain detailed information about the Default Option tabs. 
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Oracle Utilities Rate Management Toolbar 




The Toolbar gives you quick access to the program's most frequently used tools and commands. If the toolbar is not visible, select Tools-›Display ToolBar.




The following describes the function of each Toolbar button.  Additional details are provided in other parts of this guide. 








		



Click 




		



To 










		





New 






		





Not available in Oracle Utilities Rate Management .










		





Open 






		





Not available in Oracle Utilities Rate Management .










		





Save 






		



Save the currently displayed report. 










		





Print 






		



Print the currently displayed report. 










		





Export 






		



Export the currently displayed report. 










		





Cut 






		





Not applicable to Oracle Utilities Rate Management.










		





Copy 






		



Copy selected text and store it on the Clipboard. 










		





Paste 






		





Not applicable to Oracle Utilities Rate Management.










		





Browse 






		



View information in the Customer Database about selected accounts; information is displayed via the Browser. 










		





View Account 






		



View, update, add, and delete information about a selected account using the Account-Centric View. 










		





Error Window 






		



Display database version, configuration file settings, and error log. Useful when calling the Help Line. 










		





Help 






		



Display on-line help for currently displayed window. 
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Help Menu 






Help : Displays on-line help for currently-displayed window. See 

Using Online Help

 for more information.






Help contents : Displays table of contents for on-line help. See 

Using Online Help

 for more information.






About : Displays version number of software. Also displays the username, computer/network name, and database name.






Display Error Window : Displays database version, configuration settings, and error log. Especially useful when calling the HelpLine.
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Window Menu 






Cascade : Overlap multiple open windows the desktop, provides largest view of active window.






Tile : Display multiple open windows side by side.






Arrange Icons : Organize icons on Oracle Utilities Rate Management desktop.






Close All:  Closes all open windows.
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Tools Menu 






Options:  This option provides you with options for tailoring Oracle Utilities Rate Management to your needs and environment. See 

Default Options

 for more information.






Display ToolBar:  This option lets you toggle display of Toolbar on and off. See 

Oracle Utilities Rate Management Toolbar

 for more information.






Customize:  

Available in future release. This option lets you make other programs accessible from the Oracle Utilities Rate Management menu bar.






[application]:  This option opens another Oracle Utilities or user-specified application program. If other Oracle Utilities applications are not listed on your Options menu, contact your System Administrator.
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View Menu 




The View menu contains options for altering the view of reports. Note that the View menu is only available when an open report window is displayed. 






Note:  The contents of the View menu change when viewing graphs. See 

Creating Graphs

 for more information.






Graph:  Opens the Create Graph dialog and allows you to create a graph based data in the report. This option is only available if the data in the report can be graphed. See 

Creating Graphs

 for more information.






Auto Vertical Scroll:  Selecting this options causes the last page of the report to be displayed as the report progresses, if it is not checked then no automatic scrolling occurs. 






Display Only Pages With Errors:  Creates a new report window based on an open report window that contains only pages that contain errors. This option is only available if an open report window contains pages with errors.






Display Only Pages Without Errors:  Creates a new report window based on an open report window that contains only pages that contain no errors. This option is only available if an open report window contains pages with errors.
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Records Menu 




The Records menu contains options for working with records in the Oracle Utilities Data Repository. Note that the Records menu is only available when the Browser is displayed. 






Insert New:  Inserts a new record in the selected table.






Filter:  Opens the Set Filter dialog and allows you to filter records in the browser based on specified criteria. See the Data Manager User's Guide for more information.






Export:  Exports all records from a selected table, as well as all associated parent, child, and lookup records, when specified. See the Data Manager User's Guide for more information.






Delete:  Deletes all records from a selected table, as well as all associated child records. No Export file is created. See the Data Manager User's Guide for more information.






Export/Delete:  Exports all records* in a selected table, as well as all associated child records, and deletes same records from the database. See the Data Manager User's Guide for more information.






Refresh:  Refreshes the selected table.






Browse Interval Data:  This option opens the Interval Data Browser. This option is only active if you've selected the Channels, Recorders, or Channel History table, or one of the records in one of those tables. If you select a table, the Interval Data Browser displays the entire Interval Database. If you select a single record, the Interval Data Browser displays only the selected record. See the Data Manager User's Guide for more information.






Refresh All:  Refreshes all the tables in the Oracle Utilities Data Repository.








OEBPS/Text/part0098.xhtml






Turning On the Minimum Bill Report 




To include a Minimum Bill Report on a Customer Revenue Analysis, check the  Append Minimum Bill Report checkbox on the Compute Revenue for Account(s) dialog box. To include a Minimum Bill Report on a Customer Impact Analysis, check the Append Minimum Bill Report checkbox on the Customer Impact dialog box.






Note:  In order to include the Minimum Bill Report, you must include the MINIMUM_BILL_REPORT=1 parameter in the LODESTAR.CFG file. See Chapter 2: Configuration Files in the Oracle Utilities Energy Information Platform Configuration Guide for more information.
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Analysis Menu 






Customer Impact : Analyzes the potential effect of a rate change on a group of accounts. See 

Chapter 6

: 

Customer Impact Analysis (Rate Comparisons)

 for more information.






Customer Revenue : Applies a rate schedule to one or more customers' billing history over a user-specified test period and reports the number of billing units, the revenue per bill determinant, and the total revenue for each bill month and/or entire period. See 

Chapter 3

: 

Customer Revenue Analysis

 for more information.






Single Step : Calculates trial revenue by applying any rate form to a selected account's historical data over a user-specified bill month; you can execute one rate form statement at a time to see the impact of individual charges, and you can even make changes to identifier values and see the results immediately. See 

Chapter 4

: 

Single Step Analysis

 for more information.






Revenue Simulation : Allows you to determine optimum pricing by "working backwards" from the grand summary results of a Customer or Bill Frequency Revenue (in other words, once you have performed a revenue analysis, you can adjust usage values and prices until the total matches revenue requirements). See 

Chapter 5

: 

Adjusting Revenue and Price Using Revenue Simulation

 for more information.






Revenue Adequacy : Sums the revenue for multiple customer groups and determines the difference between this sum and a required total target revenue (requires that revenue analyses for each customer group have already been performed and the results saved to the database). There are two options:








		

•




		





Create:  Creates a new revenue adequacy.





















		

•




		





Open:  Opens an existing revenue adequacy.

















See  

Chapter 9

: 

Managing your Portfolio of Rate Schedules with Revenue Adequacy

 for more information.






Bill Frequency : Allows you to work with Bill Frequency tables, including the following options:








		

•




		





Create:  Creates a Bill Frequency Table for a list of customers or accounts over a specified time period.





















		

•




		





Analysis : Generates a report and/or graph describing the contents of a Bill Frequency Table.





















		

•




		





Revenue : Computes revenue for a selected group of customers over a selected time period based on a Bill Frequency Table.

















See  

Chapter 2

: 

Creating Bill Frequency Tables, Reports, and Revenue Analyses

 for more information.






Typical Bill : Analyzes the effect of a rate schedule change by simulating values for bill determinants. See 

Chapter 7

: 

Generating Typical Bill Scenarios

 for more information.






Crossing Point : Analyzes the revenue differences between two different rate schedules as determinant values vary. See 

Chapter 8

: 

Finding Crossing Points Between Rate Schedules

 for more information.






Hours Use Matrix : Generates a summary report that shows totals for revenue calculations. See 

Chapter 11

: 

Running the Hours Use Matrix Report

 for more information.
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Running a Minimum Bill Report 




The Minimum Bill Report is run as part of either a Customer Revenue Analysis or a Customer Impact Analysis report.  

Chapter 3

 and 

Chapter 6

 (respectively) describe these reports and how to run them.
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Number of Accounts Receiving a Minimum Bill 




For each rate, the number of accounts represents the cumulative number of accounts that received a minimum bill. This is not the number of individual bills or months of minimum bills. Each account is only counted once. 
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Calculated Revenue Values 




For each rate, revenue values represent the total amount for each revenue variable that was used to calculate revenues. For example, the client could input FUEL_REVENUE as one of the nine revenue variables to report. The Minimum Bill Report would include the total FUEL_REVENUE that was used to calculate revenues for each rate for all customers. The clients will always need the revenue values reported for $BASE_REVENUE and $EFFECTIVE_REVENUE. 
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Minimum Bill Report Calculations 




Billing Determinant Values 




For each rate, billing determinant values represent the total amount for each billing determinant that was used to calculate revenues. For example, the client could input KWH as one of the nine billing determinants to report. The Minimum Bill Report would include the total KWH that was used to calculate revenues for each rate for all customers.  
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Required Inputs 




In addition to the inputs required by the Customer Revenue Analysis and Customer Impact Analysis reports, the Minimum Bill report also requires that the specific billing determinants and revenue values be properly identified in the rate schedule. See  

Running a Minimum Bill Report

 for more information.
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Purpose of the Minimum Bill Report 




The Minimum Bill Report is a monthly summary report for all customers receiving a minimum bill. The report is appended to Customer Revenue Analysis (see  

Chapter 3

: 

Customer Revenue Analysis

) and Customer Impact Analysis (see 

Chapter 6

: 

Customer Impact Analysis (Rate Comparisons)

) reports.




The report is grouped by rate schedule, and shows totals for client specified billing determinant values and revenue calculations. A separate page of the report is created for the base rate and each proposed rate used in the calculation. 
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The Minimum Bill Report 




This chapter explains how to run the Minimum Bill Report, including: 








		

•




		





Purpose of the Minimum Bill Report 

























		

•




		





Minimum Bill Report Calculations 

























		

•




		





Running a Minimum Bill Report 
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Deleting a Revenue Adequacy Analysis 




How to delete an existing analysis: 








		

1.




		



Select  Analysis-›Revenue Adequacy-›Open.

















The  Revenue Adequacy dialog box appears.








		

2.




		



Complete the dialog: 



















Name:   In the Name drop-down list, select the name of the existing Revenue Adequacy analysis that you want to delete.








		

3.




		



Click  Delete.
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Running a Revenue Adequacy Analysis 




How to Create a New Analysis: 








		

1.




		



Select  Analysis-›Revenue Adequacy-›Create.

















The  New Revenue Adequacy dialog box appears.








		

2.




		



Complete the dialog: 



















Name:   Enter a name to identify the analysis.






Revenues:   Highlight each one of the previous revenue analyses that you want to include in this revenue adequacy analysis.  To highlight more than one, hold down the Shift or Option key, or drag the mouse pointer across the names.








		

3.




		



Click  OK.

















A Revenue Adequacy Window appears displaying all the revenues selected. 




How to open an existing analysis: 








		

1.




		



Select  Analysis-›Revenue Adequacy-›Open.

















The  Revenue Adequacy dialog box appears.








		

2.




		



Complete the dialog: 



















Name:   Select the name of an existing Revenue Adequacy analysis from the drop-down list.






Comment: 

Optional. Enter or edit text to describe the analysis.








		

3.




		



Click  Open.

















The Revenue Adequacy Window opens. 




How to use the Revenue Adequacy Window: 




Once a Revenue Adequacy Window is open, you have several options: 








		

•




		





Open a Revenue Simulation window for an individual revenue:  Highlight the revenue by clicking on its row label on the left side of the table, then select Revenue-›Open Revenue. The results of any changes made in this window will only be reflected in the Revenue Adequacy Window after the changes are saved and the window is closed.





















		

•




		





Add a revenue to the Revenue Adequacy table:  Select any revenue in the Revenue Adequacy Table by clicking on its row label on the left side of the table, and then select Revenue-›Insert Revenue. The Revenue Simulation dialog opens. Select the name of the revenue that you wish to add from the Name drop-down list and click Select. The revenue will be inserted after the selected revenue in the Revenue Adequacy Table.





















		

•




		





Delete a revenue from the Revenue Adequacy table:  Select the revenue in the table by clicking on its row label on the left side of the table, and then select Revenue-›Remove Revenue.





















		

•




		





Calculate the return on equity:   Select Revenue-›Info.  The Revenue Adequacy Information dialog box opens.  Enter a value in both the Rate Base and Cost to Serve edit fields.  The Return on Equity value will automatically be recalculated each time the Rate Base or Cost to Serve is changed.  Select OK to accept the entries and return to the table.  The formula for Return on Equity is:

















ROE = ((Total Revenue - Cost to Serve) / Rate Base) * 100%. 








		

•




		





Refresh the Revenue Adequacy table:   Select Revenue-›Refresh.





















		

•




		





Save the Revenue Adequacy analysis:   You can save the contents of the table by selecting File-›Save or Save as.





















		

•




		



Export the Revenue Adequacy analysis: You can export the contents of the table to a neutral format that is compatible with most spreadsheet programs (.csv or comma-separated values). To do so, selectFile-›Export. 
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Minimum Bill Report Processing 




There are three main steps involved in processing a Minimum Bill Report. 








		

1.




		



Determining if the bill is a Minimum Bill, 





















		

2.




		



Determining what Billing Determinants to display on the report (up to a maximum of 9), and 





















		

3.




		



Determining what Revenue Values to display on the report (up to a maximum of 9). 

















These steps are performed in the rate schedule used to generate the Customer Revenue/Customer Impact analysis report in which the Minimum Bill Report is included. Each of these is described in detail below. 




Determining if the bill is a Minimum Bill  




Determining if a given bill is a minimum bill is performed through use of the  IF THEN Rules Language Statement. Each rate schedule used to calculate minimum bills with the Customer Revenue and Customer Impact Analysis should have an "IF THEN" clause to determine if the bill should be a minimum bill. If the bill calculations meet (or fail to meet) a specified criteria, the bill is a minimum bill.




For example: 




IF $SUB_BILL > $MIN_BILL 




 THEN 




   BILLING_DEMAND = STANDARD_BD; 




   IGNORE $MIN_BILL, $MIN_BASE_CHARGE, $MIN_BILL_DEMAND_CHARGE; 




 ELSE 






   /* Minimum bill Report definition */ 








   INCLUDE "MINBILL"; 






   BILLING_DEMAND = MIN_BILL_BD; 




   IGNORE $SUB_BILL, $BASE_CHARGE, $STANDARD_DEMAND_CHARGE, $ENERGY_CHARGE; 




   UNBILLED KWH, PK_KVA; 




END IF; 




If the bill is a minimum bill, the specific values to be included in the report are listed using a stem.component identifier (see  Record Identifiers (stem.component) on page 4-14 in the Rules Language User's Guide) with the MIN_BILL_REPORT stem and specific values to be reported as components. For example, 




MIN_BILL_REPORT.ENERGY = KWH; 




In the example above, the MIN_BILL_REPORT identifiers are included in a rider (called MINBILL) that is included in the rate schedule using the INCLUDE Rules Language Statement. Using a rider to define the minimum bill report allows you to use the same values and definitions on all minimum bill ports by including the rider in the appropriate rate schedules. 




Determining what Billing Determinants to display and in what order. 




The MIN_BILL_REPORT identifiers are used determine what determinants will appear on the report. You can include up to nine (9) billing determinants in a single report. The order of the statements in the rate schedule or rider define where they are placed on the report. 




For example: 




MIN_BILL_REPORT.ENERGY = KWH;  




MIN_BILL_REPORT.PK_KW=PK_KW; 




MIN_BILL_REPORT.BILL_DEMAND=BILL_DEMAND; 




These statements copy the values of the determinants into these MIN_BILL_REPORT identifiers where they will be retrieved by the report generator. 




To give meaningful descriptions to the column headings, use the LABEL statement. For the above example, you could use the following LABEL statements: 




LABEL MIN_BILL_REPORT.ENERGY "kWh"; 




LABEL MIN_BILL_REPORT.PK_KW "Peak kW"; 




LABEL MIN_BILL_REPORT.BILL_DEMAND "Bill Demand"; 




Determining what Revenue Values to display and in what order. 




The MIN_BILL_REPORT identifiers are also used to determine what Revenue Values are displayed in the report. You can include up to nine (9) revenue values in a single report. The order in which they are defined in the rate schedule or riders determines the order that they will be placed in the report. Begin each MIN_BILL_REPORT identifiers with a dollar sign ($) to have the revenue value appear with a dollar sign in the report.  




For example: 




MIN_BILL_REPORT.$MIN_BILL=$MIN_BILL;  




MIN_BILL_REPORT.$EFFECTIVE_REVENUE=$EFFECTIVE_REVENUE; 




LABEL MIN_BILL_REPORT.$MIN_BILL "Min Bill"; 




LABEL MIN_BILL_REPORT.$EFFECTIVE_REVENUE "Total Revenue"; 




Important Note 




In the rate schedule, the INCLUDE statement should be placed after all the values that will be calculated as part of the minimum bill have been calculated. For instance, if the minimum bill includes values for Energy, Bill Demand, Minimum Bill and Effective Revenue values, the INCLUDE statement must appear after those values have been calculated. 
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Sample Minimum Bill Report Rate Schedule and Rider 




Below is a sample rate schedule and minimum bill report rider. 




Rate Schedule 




/* Calculate Minimum Monthly Bill */ 




$MIN_BILL = $MIN_BASE_CHARGE + MIN_BILL_DEMAND_CHARGE; 




IF $SUB_BILL > $MIN_BILL 




 THEN 




   BILLING_DEMAND = STANDARD_BD; 




   IGNORE $MIN_BILL, $MIN_BASE_CHARGE, $MIN_BILL_DEMAND_CHARGE; 




 ELSE 




   /* Minimum bill Report definition/ 






   INCLUDE "MINBILLDTL"; 






   BILLING_DEMAND = MIN_BILL_BD; 




   IGNORE $SUB_BILL, $BASE_CHARGE, $STANDARD_DEMAND_CHARGE, $ENERGY_CHARGE; 




   UNBILLED KWH, PK_KVA; 




END IF; 




MINBILLDTL Rider 




/* Large General Service Electric Service Min Bill Rider Detail Report */ 




/* Minimum Bill Detail Report definition/ 




   MIN_BILL_REPORT.ENERGY = KWH;  




   MIN_BILL_REPORT.PK_KW = PK_KW; 




   MIN_BILL_REPORT.BILLING_DET_1=BILLING_DEMAND; 




   LABEL MIN_BILL_REPORT.ENERGY "kWh"; 




   LABEL MIN_BILL_REPORT.PK_KW "Peak kW"; 




   LABEL MIN_BILL_REPORT.BILLING_DEPT_1 "Billing Demand"; 




   MIN_BILL_REPORT.MIN_BILL_REV_CHG_1 = $MIN_BASE_CHARGE; 




   MIN_BILL_REPORT.MIN_BILL_REV_CHG_2 = $MIN_BILL_DEMAND_CHARGE; 




   MIN_BILL_REPORT.MIN_BILL = $MIN_BILL;  




   MIN_BILL_REPORT.EFFECTIVE_REVENUE = $EFFECTIVE_REVENUE; 




   LABEL MIN_BILL_REPORT.MIN_REV_CHG_1 "Min Base Charge";  




   LABEL MIN_BILL_REPORT.MIN_REV_CHG_2 "Min Bill Demand Charge"; 




   LABEL MIN_BILL_REPORT.MIN_BILL "Min Bill"; 




   LABEL MIN_BILL_REPORT.EFFECTIVE_REVENUE  "Total Revenue"; 
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Required Inputs 




Before you can analyze your revenue through Revenue Adequacy, you must have performed either a Customer or Bill Frequency Revenue Analysis for each rate class of interest and have saved the results to the database. This is accomplished by selecting  Revenue-›Save from the menu bar while the Revenue Analysis Report Window is active. You may be prompted for a name and optional comment.
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Purpose of Revenue Adequacy 




A Revenue Adequacy is created from the results of many Revenue Analyses spanning a number of rate classes. The revenue values, both computed and predicted via Revenue Simulation, are displayed in a table format along with the target revenues. A total line is computed by summing the values from all of the revenues selected. The effective (computed actual), adjusted, and target revenue values, along with the actual and percent difference between the adjusted and target values, are displayed for each revenue and also the total. 




There is also additional information displayed for each revenue in the table, including the rate schedule used to produce the revenue and whether the revenue was produced from a customer list or a Bill Frequency Table. 




No fields in the Revenue Adequacy Table are directly editable. You can change the values for an individual revenue by selecting the revenue and then opening a Revenue Simulation Window for it. After saving any changes in the Revenue Simulation Window and closing it, the total line in the Revenue Adequacy Table will be recalculated. 




You may also enter values for the rate base and cost to serve into a separate dialog and Oracle Utilities Rate Management will calculate the return on equity. Revenue Adequacy tables may be saved to the database. 
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Managing your Portfolio of Rate Schedules with Revenue Adequacy 




This chapter explains how to use Revenue Adequacy analysis.  The purpose of Revenue Adequacy is to sum the revenue for several rate classes and determine the difference between this sum and a required total target revenue.  Revenue Adequacy can be used to sum both computed (actual) and predicted (adjusted or simulated) revenues so that "what-if" scenarios can be tested. 








		

•




		





Purpose of Revenue Adequacy 

























		

•




		





Running a Revenue Adequacy Analysis 

























		

•




		





Deleting a Revenue Adequacy Analysis 
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Analyzing Crossing Points 




How to Run a Crossing Point Analysis: 








		

1.




		



Select  Analysis-›Crossing Point.

















The  Crossing Point Analysis dialog box appears.








		

2.




		



Select the first rate schedule by first clicking the  Select Schedule 1 button.

















The  Select Rate Schedule and Optional Rate Code dialog box appears.








		

3.




		



Select an  Operating Company, Jurisdiction, and Rate Schedule.





















		

4.




		



Check one or more rate schedule  Types (Current/Historical or Trial).  Your selections here will determine which schedule types are displayed in the Type selection box (e.g., if you click just the Trial box, only those schedules stored as "Trial" will be available for selection in theselection box).





















		

5.




		



Highlight one rate schedule in the selection box.

















To help you make your selection, Oracle Utilities Rate Management displays the first 50 lines of the selected rate schedule text in the lower window. If you wish to view the entire schedule (beyond 50 lines), click  Show All. The text in this window is view-only—you cannot edit the schedule here.








		

6.




		



If the rate schedule includes SELECT RATE CODE statements that apply different calculations for different rate codes, you must select one of the rate codes to be used in the analysis run.  There are two options: 





















		

•




		



Select a rate code using the  From Rate Schedule Rate Code drop-down list, or





















		

•




		



Leave the  From Rate Schedule Rate Code field empty.  In that case, Crossing Point applies the first rate code in the schedule.





















		

7.




		



Click  OK to return to the Crossing Point Analysis dialog box.





















		

8.




		



Select a second rate schedule by clicking  Select Schedule 2 and repeating steps 3 through 7.





















		

9.




		



Select one bill determinant from the  Determinant drop-down list.





















		

10.




		



Under  Values, provide one value or a range of values for the determinant selected. If you include one or two determinants, you must include all three values (Low/Constant, High, and Step) for each. For the third and subsequent determinants, you can only supply the Low/Constant value.





















		

11.




		



Click  Add to add the determinant to the list of determinants and values that are being simulated for the analysis.





















		

12.




		



Repeat steps 9 through 11 as many times as you like, up to a maximum of six.  At least one determinant must have a range of values specified. If you do not provide a value, it defaults to zero.





















		

13.




		



Under  Min Diff, supply a minimum difference amount if you want to limit the report output to the combinations of billing determinants that fall within a certain range of differences between rate schedules.





















		

14.




		



Under  Date, enter a date (MM/YYYY) for Crossing Point to use when it comes across rate schedule computations that involve seasons.





















		

15.




		



Under  Generated Determinant, click Compute and either kW, kWh, or Load Factor if you want to compute one of those determinants from your simulated billing determinant values.





















		

16.




		



Click  Set Code, if you want to match the billing determinant code to the generated determinant. The Set Determinant Code dialog box appears.





















		

17.




		



Complete the dialog as follows: 





















		

•




		



For  kWh, select the determinant code that you use to represent kWh if you are computing kW or Load Factor.





















		

•




		



For  kW, select the determinant code that you use to represent kW if you are computing kWh or Load Factor.





















		

•




		



For  Load Factor, select the determinant code that you use to represent Load Factor if you are computing kW or kWh.





















		

18.




		



Click  OK to return to the Crossing Point dialog.





















		

19.




		



Graph or report the results by clicking  Graph or Report.



















Note:  If you want to graph the results, be sure that the Keep Data option in the Report Options dialog box is checked.
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Required Inputs 




Before you can perform crossing point analysis, you must have already created and saved the rate schedules you wish to analyze. 
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The Purpose of Crossing Point Analysis 






Crossing Point Analysis  lets you compare the revenue differences between two different rate schedules as determinant values vary.  You can specify what determinants will be used, which will be held constant, and which will vary during the crossing point calculation.  The maximum number of variable determinants is six.




In general, the crossing point computation consists of a series of nested loops.  Each loop represents one variable determinant that changes value each time the loop is iterated.  The threshold minimum value computation involves finding the minimum revenue difference between rate schedules that fall within the +/- difference provided by the user.  Only minimum values that exclusively fall within the supplied threshold are reported.  Minimum values that fall outside of the threshold or equal to the threshold are ignored. 




Crossing Point produces one type of report, which you can save and print. 




Any information on the report can be graphed and analyzed further.  You can save and print graphs. 




Crossing Point can also be run in batch mode using a command line program. For more information, see  

Crossing Point

 of 

Appendix B

: 

Setting Up Oracle Utilities Rate Management to run in Batch Mode

.
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Finding Crossing Points Between Rate Schedules 




This chapter explains how to use Crossing Point analysis.  Crossing Point compares the revenue differences between two different rate schedules as determinant values vary. 








		

•




		





The Purpose of Crossing Point Analysis 

























		

•




		





Analyzing Crossing Points 
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Running a Typical Bill Analysis 




How to Run a Typical Bill Analysis: 








		

1.




		



Select  Analysis-›Typical Bill.

















The  Typical Bill Analysis dialog box appears.








		

2.




		



Select the first rate schedule by first clicking  Select Schedule 1.

















The  Select Rate Schedule

and

Optional Rate Code dialog box appears.








		

3.




		



Select an  Operating Company, Jurisdiction, and Rate Schedule.





















		

4.




		



Check one or more rate schedule  Types (Current/Historical or Trial).  Your selections here will determine which schedule types are displayed in the Type selection box (e.g., if you click just the "Trial" box, only those schedules stored as "Trial" will be available for selection in the selection box.





















		

5.




		



Highlight one rate schedule in the selection box. 





















		

6.




		



The program requires a rate code to determine how to price out the billing determinants.  There are three options: 





















		

•




		



Select a rate code from the  From Rate Schedule Rate Code list. If you do not select a rate code, the program will use the customer's current rate code to determine the correct pricing.





















		

•




		



Check  Inter-schedule Mapping. Oracle Utilities Rate Management will check the Inter- Schedule Mapping Table to determine how to map the rate code.





















		

7.




		



Click  OK to return to the Typical Bill Analysis dialog box.





















		

8.




		





Optional.  Select a second rate schedule to compare with the first by clicking Select Schedule 2 and repeating steps 3 through 7.





















		

9.




		



In the  Typical Bill Analysis dialog box, specify the Bill Month using the MM/YYYY format.





















		

10.




		



Specify the first determinant and value for simulation: 





















		

•




		



In the  Determinant field, select one determinant from the drop-down list (this list box contains all determinants in the rate schedule(s)).





















		

•




		



Under  Values, provide one value or a range of values for the determinant selected.





















		

11.




		



Click the  Add/Update button to add the determinant to the list of determinants and values that are being simulated for the analysis.





















		

12.




		



Repeat steps 10 and 11 as many times as there are determinants in the list box. At least one determinant must have a range of values specified. If you do not provide a value, it defaults to zero. You can select up to a maximum of 12 determinants for the analysis. 





















		

13.




		



If you want to include cents per determinant in your report, click  Advanced.  Otherwise, go to step 15.

















The  Advanced Typical Bill dialog box appears.








		

14.




		



Check the  Compute

 Cents per Determinant option to get an additional column on the Typical Report with the cents per determinant for each rate schedule you selected. Then, choose the determinant you wish to report.





















		

15.




		



If you want to define additional report options, such as adding report titles and saving the results to a file, click  Report Options (see the on-line help for details). Note: If you want to graph the results, be sure that the Keep Data option under Report Options is checked.





















		

16.




		



Click  OK to return to the Typical Bill dialog box.





















		

17.




		



You have two options for outputting the results of the analysis: 



















Graph:   Creates a graph and report of the results.






Report:   Creates a tabular report.








		

18.




		



Once you have created the report, you can export or print it through the  File menu.
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Required Inputs 




Before you can perform a typical bill analysis, you must have already created and saved the rate schedule or schedules you wish to analyze. 
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The Purpose of Typical Bill Analysis 




Oracle Utilities Rate Management Typical Bill Analysis lets you analyze the effect of a change in a rate schedule by simulating values for billing determinants. The report shows the revenue from different values of a combination of billing determinants. You can analyze one rate or compare the difference between two rates. 




The report shows the revenue for each scenario, the difference between two rate schedules, and cents per a user-defined determinant. Different revenue months in a year can be analyzed if seasonality differences exist in a rate schedule. 




Typical Bill produces one report, which you can save and print. 




Any information on the report can be graphed and analyzed further. You can save and print graphs. 




Typical Bill can also be run in batch mode using a command line program. For more information, see  

Typical Bill

 of 

Appendix B

: 

Setting Up Oracle Utilities Rate Management to run in Batch Mode

.








